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You will have mastered the muteml in this project
when you can:

@ Start Excel
B Describe the Excel worksheet .
# Describe the speech recognition capabilities

of Excel

Select a cell or range of cells
Enter text and numbers

B =

Use the AutoSum button to sum a range of cells

Copy a cell to a range of cells using the fill
handle
Bold font, change font size, and change font color

A Center cell contents across a series of columns

5

4

Apply the AutoFormat command to format a
range

Use the Name box to select a cell

Create a Column chart using the Chart Wizard

Save a workbook

Print a worksheet

Quit Excel

Open a workbook

Use the AutoCalculate area to determine totals
Correct errors on a worksheet

-

Use the Excel Help system to answer your
questions




Creating a Worksheet
and Embedded Chart
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Three years ago while in college, Nadine
Mitchell and four of her friends came up
with the idea of starting o company that
sold music to young adults through store
outlets in malls. After graduation, they
invested $5,000 each and started their
dream cormpany, Dynamite Music,

The friends opened their first music store
in Boston. Initially, they sold compact
discs, cassettes, and rare records {vintage
vinyls), As sales grew, they opened addi-
tional outlets in Chicago, Denver, and
Phoenix. Last year, they started selling
their products on the Web. Rather than
use o central Web site for Web sales,
they decided to maintain Web sites for
each store. This year they began fo sell
music by allowing customers to dowrra.
load music to their personal computers.

As sales continue to grow, the manage-
ment at Dynamite Music has realized it
needs a better tracking system for sales
by quarter. As a result, the company has
asked you to prepare a fourth quarter
sales worksheet that shows the sales for
the fourth quarter.

In addition, Nadine has asked you to
create a graphical representation of the
fourth quarter sales because she finds it

easier to work with than lists of numbers,

PROJECT

hat Is Microsoft Excel?

Microsoft Excel is a powerful spreadsheet program that allows you
to organize data, complete calculations, make decisions, graph
data, develop professional looking reports, publish organized
data to the Web, and access real-time data from Web sites. The
four major parts of Excel are:

B Worksheets Worksheets allow you to enter, calculate,
manipulate, and analyze data such as numbers and text.
The term worksheet means the same as spreadsheet,

B Charts Charts pictorially represent data. Excel can draw a
variety of two-dimensional and three-dimensional charts,

B Databases Databases manage data. For example, once you
enter data onto a worksheet, Excel can sort the data, search
for specific data, and select data that satisfy a criteria.

B Web Support Web support allows Excel to save
workbooks or parts of 2 workbook in HTML format
so they can be viewed and manipulated using a browser,
You also can access real-time data using Web queries.

A roject One — Dynamite Music
Fourth Quarter Sales

From your meeting with Dynamite Music’s management,
you have determined the following: needs, source of data,
calculations, and chart requirements,

Needs: An easy-to-read worksheet (Figure 1-1) that shows
Dynamite Music’s fourth quarter sales for each of the product
groups (Cassettes, Compact Discs, Vintage Vinyls, and Web
Downloads) by store (Boston, Chicago, Denver, and Phoenix).
The worksheet also should include total sales for each product
group, each store, and total company sales for the fourth quarter,
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Dynamite Music

Fourth Quarter Sales

Boston Chicago Denver Phoerix fotaf

T Cassetles § 53465309 47917.35(% 31913.75 | §_62,350.10 | $195 846,50

P8 Compact Discs | 92023.75 | 70392.10{ 96,14055 ] 8345075 | 332,007.15 | ¢ | data in
|6 [Vintage Vinyls | 3540255 | 3007625 | ABG12761 3409275 14916431 worksheet
5 veb Downloads | 7852612 | 67,6260 | 6742020 | 5673280 | 270,305.72

Eg;}ﬁ Total ~ $7259.497.73 | $216,912.30 [ §234,087.25 | $236526.40 | §$947.123.68
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FIGURE 1-1

Source of Data: The data for the worksheet is available at the end of the fourth
quarter from the chief financial officer (CFO) of Dynamite Music.

Calculations: You have determined that the following calculations must be made
for the worksheet: (a) total fourth quarter sales for each of the four product groups;
(b) total fourth quarter sales for each of the four stores; and (c) fourth quarter sales
for the company.

Chart Requirements: Below the worksheet, construct a 3-D Column chart that
compates the amount of sales for each product group within each store.

]
btarting and Customizing Excel

e

To start Excel, Windows must be running. Perform the steps on the next page to
start Excel, or ask your instructor how to start Excel for your system.

“Excel 2002

With its. smart tags, speech
recognition, shartcut menus,
toelbars, whatif analysis tools,
Web capabilifies, hundreds of
furictions; and speach play-
back, Excel 2002 is one of
the easiest, and yel most pow-
erful, worksheet packages
available. Ifs powerful analyti-
cal features make it possible
to answer complicated whatit
questions. Its Web capabilities
allow you to create, publish,
view, and andlyze data on an-
infranet or the World Wide
Web.

ELO7
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Click the Start
button on the
Windows taskbar, point to
Programs on the Start
menu, and then point to
Microsoft Excel on the
Programs submenu.

The commands on the Start
menu display above the Start
button and the Programs
submenu displays

(Figure ?-2) h( the Start
Office Speech eny

Recognition software
is installed on your computer;
then the Language bor may
display somewhere on the
desktop. Start

" bulton

FIGURE 1-2

Cllck [ tille baL
Microsoft Excel.

Excef starts. After several
seconds, a blank workbook
fitled Book! displays in the
Excel window (Figure 1-3).

g If the Excel window
&4 s not maximized,
double-click its title bar to

maximize it.

1

Doublecl:ck Excel |con on

:rni:ab doublecllck
Blan Workbook |con

- Microsoft §

prfarm caleulations, analyze information, and managa lists in I
sp readsheets or Web pages by  Microsoft Excel; -

Back
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SRS - tille
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ffj Templates en Microsoft,com

task.pane—.
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{Z} taicrosoft Excel Help
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FIGURE 1-3
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The screen in Figure 1-3 shows how the Excel window looks the first time
you start Excel after installation on most computers. If the Office Speech
Recognition software is installed on your system, then when you start Excel
either the Language bar expands to include the functions available in Excel
(shown at the top of Figure 1-3} or the language indicator displays on the
right side of the Windows taskbar (Figure 1-7 on page E 1.11). In this book,
the Language bar will be kept minimized until it is used. For additional
information about the Language bar, see page E 1.16 and Appendix B.

Notice also that a task pane displays on the screen, and that the buttons on i More "
the toolbar display on a single row. A task pane is a separate window that enables The Excell-lelp
users to carry out some Excel tasks more efficiently. In this book, to allow the SYSI'GIII‘I _

maximum number of columns to display in Excel, a task pane should not display.
For more efficient use of the buttons, they
should display on two separate rows instead of
sharing a single row. Perform the following steps
to close the New Workbook task pane, minimize
the Language bar, and display the buttons on

Need Help? It is no further
away than the Ask .a-GQuestien
box in the upperright corner
of the window, Click the box
that contains the text, Type a
question for help {Figure 1-4),.

- ST e help, and then press the
two separate rows. '(IS_I( P-“n_es tZ\IF:'ER key. Excel will rispond :
You con drag a task pane with a list of items you can
tille bar {Figure 1-3) fo Roat dick to learn about obtaining
the pane in your work area help on any Excelrelated
or dock it on either the left topic. To find out what is new
or right side of a screen, in Excel 2002, type what's
depending on your personal new in Excel in the Ask a
preference. Question box.

button

] To Customize the Excel Window | Ninimize

If the New
Workbook task
pane displays in your
Excel window, click the
Show at startup check hox
1o remove the check mark

and then click the Close ST i task pane |
button in the upper-right : 1 closed addoni |

corner of the task pane
(Figure 1-3). If the
Language bar displays,
point to its Minimize
bution.

Excel removes the check
mark from the Show at
startup check box. With
the check mark removed,
Excel will not display the
New Workbook task pane
the next time Excel starfs.
The New Workbook task
pane closes resufting in
additional columns
displaying (Figure 1-4).

FIGURE 1-4
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buttens on
one row

Click the Minimize
button on the
Language bar. If the
toolbars display positioned
on the same row, click the
Toolbar Options bution and F .

< ;
| Toslkar Qptions |
: bution o

hﬁ%ﬂ?&ns
then point to Show Buitons 1 on Two Rows f
on Two Rows.

command |- . i
Add or Remove Buttons . chlba:’is?ptlnns

L el

The Toolbar Options list £ A
displays showing the buttons SRR
that do not fit on the toolbars
when butions display on one
row (Figure 1-5).

FIGURE 1-5

Click Show Butions

£ Miciosoft Exce! - Book1
REo TR
on Two Rows.

Excel displays the buttons
on fwo separate rows
(Figure 1-6). The Toolbar
Options list shown in
Figure 1-5 is empty
because all of the buftons
display on two rows.

FIGURE 1-6

As you work through creating a worksheet, you will find that certain Excel
operations result in displaying a task pane. Besides the New Workbook task pane
shown in Figure 1-3 on page E 1.08, Excel provides three additional task panes: the
Clipboard task pane, the Search task pane, and the Insert Clip Art task pane. These
4 task panes are discussed when they are used. You can display or hide a task pane by
clicking the Task Pane command on the View menu. You can activate additional task
panes by clicking the down arrow to the left of the Close button on the task pane
title bar (Figure 1-3) and then selecting a task pane in the list. Using the Back and
Forward buttons on the left side of the task pane title bar, you can switch between
task panes.

Worksheei
Development

The key to developing o useful
worksheet is careful planning.
Carehul planning can reduce
your effort significantly and
result in a worksheet that is
accurate, easy fo read, flexi-
ble, and useful. When analyz-
ing o problem and designing
a warksheet solution, you
should follow these sleps:

|1} define the problem, includ-
ing need, source of data, cal-
culations, charting and Web

he Excel Worksheet

When Excel starts, it creates a new blank workbook, called Book1. The workbook
(Figure 1-7) is like a notebook. Inside the workbook are sheets, called worksheets.
Fach sheet name displays on a sheet tab at the bottom of the workbook. For exam-
ple, Sheet1 is the name of the active worksheet displayed in the workbook called

or special requirements;
(2} design the worksheet;
{3} enter the data and
formulas; and {4) test the
worksheet,

Book1. A new workbook opens with three worksheets. If necessary, you can add
additional worksheets to a maximum of 255. If you click the tab labeled Sheet2,
Excel displays the Shect2 worksheet. This project uses only the Sheet1 worksheet.
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FIGURE 1-7
The Worksheet

The worksheet is organized into a rectangular grid containing columns
(vertical) and rows (horizontal). A column letter above the grid, also called the
column heading, identifies each column. A row number on the left side of the grid,
also called the row heading, identifies each row. With the screen resolution set to
800 x 600, 12 columns (A through L) and 24 rows (1 through 24) of the worksheet
display on the screen when the worksheet is maximized as shown in Figure 1-7.

The intersection of each column and row is a cell. A cell is the basic unit of a
worksheet into which you enter data. Each worksheet in a wotkbook has 256
columns and 65,536 rows for a total of 16,777,216 cells. The column headings begin
with A and end with IV, The row headings begin with 1 and end with 65,536.

Only a small fraction of the active worksheet displays on the screen at one time.

A cell is referred to by its unique address, or cell reference, which is the
coordinates of the intersection of a column and a row. To identify a cell, specify
the column letter first, followed by the row number. For example, cell reference
CS refers to the cell located at the intersection of column C and row 5 (Figure 1-7).

One cell on the worksheet, designated the active cell, is the one into which you
can enter data. The active cell in Figure 1-7 is A1. The active cell is identified in
three ways. First, a heavy border surrounds the cell; second, the active cell reference
displays immediately above column A in the Name box; and third, the column head-
ing A and row heading 1 are highlighted so it is easy to see which cell is active
(Figure 1-7).

scroll
arrows l

The Worksheet Size
and Window

256 columns and 65,536
rows make for a huge work-
sheet that you might imagine
takes up the entire wall of a
large room. Your computer
screen, by comparison, is @
small window that allows you
to view only a minute area of
the worksheet at one time.
While you can't see the entire
workshest, you can move the
windaw over the worksheet to
view any part of it. To display
the last row in a blank work-
sheet, press the END key and
then press the DOWN ARROW
key. Press CTRL+HOME to return
to the top of the worksheet.
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“symbol; Repanding on.
you are performing:in Excel
and the mouse pointer's -~
location on the screen.”

epending on'the task.

Increusing the
Viewing Aren
IF you sednt to ingrease the
siza of the viewing area to ses
‘more of the worksheet, click
Full Screen on the View menu.
You can also ingrease the
viewingarea by changing to
a higher resolution. You
change to g.higher resolution
by rightclicking the Windows
desktop, clicking Properties, -
clicking the Seftings tab, and
incredising the Screen area,
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The horizontal and vertical lines on the worksheet itself are called gridlines.
Gridlines make it easier to see and identify each cell in the worksheet, Tf desired,
you can turn the gridlines off so they do not display on the worksheet, but it is
recommended that you leave them on.

The mouse pointer in Figure 1-7 on the previous page has the shape of a block
plus sign. The mouse pointer displays as a block plus sign whenever it is located in a
cell on the worksheet. Another common shape of the mouse pointer is the block
arrow. The mouse pointer turns into the block arrow whenever you move it outside
the worksheet or when you drag cell contents between rows or columns. The other
mouse pointer shapes are described when they display on the screen.

rksheet Window

You view the portion of the worksheet displayed on the screen through a worksheet
window (Figure 1-7). Below and to the right of the worksheet window are scroll bars,
scroll arrows, and scroll boxes that you can use to move the window around to view
different parts of the active worksheet. To the right of the sheet tabs at the bottom of
the screen is the tab split box. You can drag the tab split box (Figure 1-7) to increase
or decrease the view of the sheet tabs. When you decrease the view of the sheet tabs,
you increase the length of the horizontal scroll bar, and vice versa.

The menu bar, Standard toolbar, Formatting toolbar, formula bar, and Ask a
question box display at the top of the screen, just below the title bar {Figure 1-8a).

Menv Bar

The menu bar is a special toolbar that includes the menu names (Figure 1-8a).

Each menu name represents a menu of commands that you can use to retrieve, store,
print, and manipulate data on the worksheet. When you point to a menu name on
the menu bar, the area of the menu bar containing the name changes to a button.
To display a menu, such as the Edit menu, click the Edit menu name on the menu
bar (Figures 1-8b and 1-8c). A menu is a list of commands. If you point to a com-
mand on the menu with an arrow to its right, a submenu displays from which you
can choose a command,

When you click a menu name on the menu bar, a short menu displays listing the
most recently used commands (Figure 1-8b). If you wait a few seconds or click the
arrows at the bottom of the short menu, the full menu displays. The full menu lists all
the commands associated with a menu (Figure 1-8c). You also can display a full
menu immediately by double-clicking the menu name on the menu bar. In this book,
when you display a menu, always display the full menu using one of the following
techniques.

>

1. Click the menu name on the menu bar and then wait a few seconds.

2. Click the menu name and then click the arrows at the bottom of the short menu.

3. Click the menu name and then point to the arrows at the bottom of the short
menu.

4. Double-click the menu name,

Both short and full menus display some dimmed commands that appear gray, or
dimmed, instead of black, which indicates they are not available for the current
selection. A command with a dark gray shading to the left of it on a full menu is
called a hidden command because it does not display on a short menu. As you use
Excel, it automatically personalizes the short menus for you based on how often you
use commands. That is, as you use hidden commands, Excel unhides them and places
them on the short menu.
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(b) Short Menu

The menu bar can change to include other menu names depending on the type
of work you are doing in Excel. For example, if you are working with a chart sheet
rather than a worksheet, the Chart menu bar displays with menu names that reflect

charting commands.

hicden
commands not an
short menu

Standard Toolbar and Formatting Toolbar

The Standard toolbar and the Formatting toolbar (Figure 1-8a} contain buttons
and list boxes that allow you to perform frequent tasks more quickly than when
using the menu bar. For example, to print a worksheet, you click the Print button
on the Standard toolbar. Each button has a picture on the button face that helps you
remember the button’s function. Also, when-you move the mouse pointer over a-
button ot box, the name of the button or box displays below it in a ScreenTip.

Figures 1-9a and 1-9b on the next page illustrate the Standard and Formatting

FIGURE 1-8

-
q Delete Sheet s o

t:rl+2

Can't Repesat Cirley
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Office Clipboard...

Cerlty

Paste as Hyperlink <l

... | commands on
full Edlt menu

Move or Copy Sheet...

{c<) Full Menu

Toolbhaurs

You can move a toolbar to
any location an the screen.
Drag the move handle
{Figure 1-10a on page

E 1.14) to the desired loca-
tion. Once the toolbar is in the
window ared; drag: the fitle
bar to move it. Each side of
the screen is called o dock.
You can drag a toolbar to a
dock so it does not clutter the
window.

toolbars and describe the functions of the buttons. Each of the buttons and boxes
will be explained in detail when they are used.




(a) Stondard Toolbar

(b) Formatting Toolbar

FIGURE 1-9

- 5 Rl 4 When you first install Excel, both the Standard and Formatting toolbars are
Resetting Toolbars preset to display on the same row (Figure 1-10a), immediately. below the menu bar.
If your toolbars have a Unless the resolution of your display device is greater than 800 x 600, many of the
different set of butions than buttons that belong on these toolbars do not display. Hidden buttons display in the
shown in Figure 1-10c, it - Toolbar Options list (Figure 1-10b). In this mode, you also can display all the but-

probably means that a previ. tons on either toolbar by double-clicking the move handle on the left of each toolbar
ous user added or deleted bul-

" tons, To reset the foolbars to (Figure 1-10a).

their default, see Apperdix D. e e partial
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(b} Toolbar Options List

all buttons show
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are on two rows

(¢) Standard and Formatting Toolbars on Two Rows

FIGURE 1-10

In this book, the Standard and Formatting toolbars are shown on two rows, one
under the other so that all buttons display (Figure 1-10c). You show the two toolbars
on two rows by clicking the Show Buttons on Two Rows command in the Toolbar
Options list (Figure 1-10b).




Formula Bar

Below the Standard and Formatting toolbars is the formula bar (Figure 1-11).
As you type, the data displays in the formula bar. Excel also displays the active cell
reference on the left side of the formula bar in the Name box.

Status Bor

Immediately above the Windows taskbar at the bottom of the screen is the status
bar. The status bar displays a brief description of the command selected (highlighted)
in a menu, the function of the button the mouse pointer is pointing to, or the mode
of Excel. Mode indicators, such as Enter and Ready, display on the status bar and
specify the current mode of Excel. When the mode is Ready, Excel is ready to accept
the next command or data entry. When the mode indicator reads Enter, Excel is in
the process of accepting data through the keyboard into the active cell.

In the middle of the status bar is the AutoCalculate area. The AutoCaleulate area
can be used in place of a calculator to view the sum, average, or other types of totals
of a group of numbers on the worksheet. The AutoCalculate area is discussed in
detail later in this project.

Keyboard indicators, such as caps (Caps Lock), num (Num Lock), and SCRL
(Scroll) show which keys are engaged. Keyboard indicators display on the right
side of the status bar within the small rectangular boxes (Figure 1-11).

B Microseft Excel - Baok1

AT ThJET T TR RITM A W - s ¥

-Si:mg 'loolbur
‘Buttons

IE yéiu have dlfhculty seemg
the small buttons oni‘the. tocl-
bars, you can ingrease their
size: by clicking View. on

the menu bar, pointing:to
Toolbars, clicking Customize
on the Toolbars submenu,
dhicking the Options ab, click-
ing the Large icons checkbox,
and clicking the Close butian.

2l . formula
SR | Insert bar R
I Name tox | Function boxj | Hrewermpesee
,1 i S B e SIS

keyboard
mode A S h}:g:g:rs AutoCalculate ¥~ indicators |
indigator e T ] T I area [t A

FIGURE 1-11
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peech Recognition and Speech Playback

With the Office Speech Recognifion software installed and a microphone, you can
speak the names of toolbar buttons, menus, menu commands, list items, alerts, and
dialog box controls, such as OK and Cancel. You also can dictate cell entries, such
as text and 11umbcrs To indicate whether you want to speak commands or dlctate
cell entries, you use
ey the Language bar

! EN is .. language Microphone ©  Diotati V C d i S h 11 On-screen | Mn

{ abbroviation * . currenlly . Microphone . Dictation 'vice Comman pesch | euhoard | | M imize | ) i

| o English . seleola * button bution [ bution _| Too1s bullonli bt | 1 .[';.ug};-,?.! (Flgurlc 1-12a). You
T T ' - f R can dlsplay the

Language bar in two
ways: (1) click the
Language Indicator

. ey - RSN
. bal!oon reveals i Handwriling . ;i Help . : Opticns . X
ispoken phiase orVoice | ;  bution | buton | | button button in the taskbar
. Gommandstatys | e e tray status area by the
{a) Language Bar ClDCk, and then click

Show the Language
bar on the menu
(Figure 1-12b);
t (2) point to the
Speech command on the Tools menu and then click the Speech
Recognition command on the Speech submenu.

If the Language Indicator button does not display in the
tray status area, and if the Speech command is dimmed on the
Tools menu, the Office Speech Recognition software is not
installed. To install the software, you first must start Word
and then click Speech on the Tools menu.

If you have speakers, you can instruct the computer to
read a worksheet to you. By selecting the appropriate option,
{b) Language Bar Menu you can have the worksheet read in a male or female voice.

Additional information on the speech recognition
and speech playback capabilities in Excel is available in
Appendix B,

R S SNSRI A R BN Er‘ghsh {United States)
2l English {Zimbabwe)

| Franch (Canada)
a5 mj French (France)
DE] German (Germany)

command

Languwage Indicator
button in tray slates area
on Windows taskbar 8

FIGURE 1-12

electing a Cell

To enter data into a cell, you first must select it. The casiest way to select a cell
(make it active) is to use the mouse to move the block plus sign to the cell and
then click.

An alternative method is to use the arrow keys that are located just to the right

Seletiing a Cell of the typewriter keys on the keyboard. An arrow key sclects the cell adjacent to the

You can select any cell by active cell in the direction of the arrow on the key.

enfering the cell reference, You know a cell is selected (active) when a heavy border surrounds the cell

such as b4, in the Name (cell A1 in Figure 1-11 on the previous page) and the active cell reference displays |

box on the left side of the

in the Name box on the left side of the formula bar. I
formula bar.

R
%ﬁ% .
i.«ntering Text
In Excel, any set of characters containing a letter, hyphen (as in a telephone

number}, or space is considered text. Text is used to place titles on the worksheet,
such as worksheet titles, column titles, and row titles. In Project 1 (Figure 1-13),
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the worksheet title,

Dynamite Music, identifies
the worksheet. The work-
sheet subtitle, Fourth , : cala
Quarter Sales, identifies the | : : Gl R

e of report. The column
t,yp L p worksheet —*“P"Dynamlte MUSIC worksheet
titles in row 3 (Boston, titte o sublitle —
Chicago, Denver, Phoenix, Fourth Quarter Sales . por
Baston Chicago Danver Phoenix Total o urmn
and Total) identify the num- Casseiles § 6345530 | § 47.917.35 | 5 31913.75 | § 5235010 | §195,645,50 tlas
. Gornpact Discs | 9202375 | 70.303.10 | BBAM055 | 8346076 | 332007 06 | 1T

bers in each col- o Ulles j ' 3548366 | 097625 | 4851275 | 3409275 | 149,164.31
umn. The row [ }Web Downloads |~ 7862612 | 67620560 | 67,4090 | 5679280 | 2/0.305.72

$260 407 73 | 5216.912.30 | 5234 D67.25 | $236 626,40 | $947 123.69

titles in column A
(Cassettes, Compact Discs,

Vintage Vinyls, Web $100,000.00
Downloads, and Total)

identify the numbers ; o ;

in each row. URE 1-13

Entering the Worksheet Titles : kl :

The following steps show how to enter the worksheet titles in cells Al and A2. A text entry in a cell can
Later in this project, the worksheet titles will be formatted so it displays as shown in contain from 1 to 32,767 char-
Figure 1-13. Perform the following steps to enter the worksheet tiles. acters. Although fext entries

are primarily used to identify

parls of the worksheet, there
are applications:in which text

. enfries gre dala that you dis-
Wﬁ) Enter the Worksheet Titles et sime togathern, and

manipulate using text functions.
Click cell Al.
.

Cell A1 becomes the active
cell and a heavy border
surrounds it (Figure 1-14).

I selected

text displays
in formula bar

Type Dynamite
Music in cell AL,

The ' title displays in the
formula bar and in cell Al.
The text in cell Al is followed T
by the inserfion point ien "57 - point

(Figure 1-15). The inser- ot N R — -

. Lo . mouse pointer |
tion point is  blinking becormes an
vertical line that indicates b
where the next typed

character will display.

text displays in active i ’ b S IO SO
cell and overflows inlo ) :
adj ent cell to the righ

2uchr

FIGURE 1-15




Point to the Enter
. box (Figure 1-186).

““When you begin typing a
“Call.entry, Excel displays two

- gdditional boxes in the for-
mula bar: the Cancel box
and the Enter box.

Click the Enter box
to complete the

enfry.

Excel enfers the worksheet
tite in cell Al (Figure 1-17).

Click cell A2 to
select it. Type
Fourth Quarter Sales
as the cell entry. Click the
Enter box to complete the
entry.

Excel enters the worksheet
subtifle in cell A2
(Figure 1-18).

1. To complete entry, click any
csll other than active cell

2. To complete entry, press
" ENTER key
3. To complete eniry, press
HOME, PAGE UP, PAGE DOWN,
‘of END key '
4. In Yoice Command mode
say, "Enter” 1o complete entry

Gancel box I

~Enter box Type a question For halp

= o 52 T AR s 2}, i d ] .
i sl IR ; S o sa 7 T
Arlal (s 5 ¥ KN sk e TIRE 4 il X G
[N ﬂ \! LR E-'_ G AN D A% S A e . 2 2
: ; Dynamite Music_
ZlDyhamite Music) E“tii'lqlmm rimer s . ]
S5 T SereenTip idenlifies . 3
3 g box to which mouse [~ -
I ot 4 ‘pointer is pointing 3 i i
4 i

R R s B e R s Rl S e
FIGURE 1-16

. Cancel box no
fonger display

Type a questlon for help

5

£

]

o]
Righe

ZA8|Dynarnite

text entared ] ) ]
into cell A1 ) T ]

into cell A2

- waorksheet
sublille entered

FIGURE 1-18

In Steps 3 and 4, clicking the Enter box completes the entry. Clicking the Cancel
box cancels the entry.

When you complete a text entry into a cell, a series of events occurs. First, Excel
positions the text left-aligned in the cell. Left-aligned means the cell entry is posi-
tioned at the far left in the cell. Therefore, the D in the worksheet title, Dynamite
Music, begins in the leftmost position of cell Al.

Second, when the text is longer than the width of a column, Excel displays the
overflow characters in adjacent cells to the right as long as these adjacent cells con-
tain no data. In Figure 1-17, the width of cell A1 is approximately nine characters.
The text consists of 14 characters. Therefore, Excel displays the overflow characters
from cell A1 in cell B1 because this cell is empty. If cell B1 contained data, only the
first nine characters in cell A1 would display on the worksheet. Excel would hide the
overflow characters, but they still would remain stored in cell A1 and display in the
formula bar whenever cell A1 is the active cell.




Third, when you complete an entry by clicking the Enter box, the cell in which
the text is entered remains the active cell.

Correcting u Mistake While Typing

If you type the wrong letter and notice the error before clicking the Enter box
or pressing the ENTER key, use the BACKSPACE key to erase all the characters back to
and including the one that is wrong. To cancel the entire entry before entering it into
the cell, click the Cancel box in the formula bar or press the BscC key. If you see an
error in a cell, select the cell and retype the entry. Later in ‘this project, additional
error-correction techniques are discussed.

AvtoCorrect

The AutoCorrect feature of Excel works behind the scenes, correcting common
mistakes when you complete a text entry in a cell. AutoCorrect makes three types
of corrections for you:

1. Corrects two initial capital letters by changing the second letter to lowercase.
2. Capitalizes the first letter in the names of days.
3. Replaces commonly misspelled words with their correct spelling. For example,

it will change the misspelled word recieve to receive when you complete the
entry. AutoCorrect will correct the spelling automatically of more than 400
commonly misspelled words.

Entering Column Titles

To enter the column titles in row 3, select the apploprlate cell and then enter the
text, as described in the following steps.

Cell B3 becomes the active
cell. The active cell reference

Libeiitly fenld

LB E A

The ENTER Key

When you first install Excel,
the ENTER key not-only com-
pletes the ¢ritry but moves the
setection-to an.adjacerit cell.
You can instruet Excel not to
move the selection after-press-
ing the enTER key by clicking
Oplions on the Tools menu,
clicking the Edit tab, removmg :
the check mark from the Move
Selection after Enter check
box, and then clicking the OK
button. '

T

s

S Morel

The IntelliSense™
Technology

Office XP's IntelliSense™
Technology tries to understand
what you are doing and helps
you do it. The adoptive
menus, Ask a Question box,
AutoCarrect, AutoComplete,
smart tags, and formula error
checker are part of the
IntelliSense™ Technology. For
more information-on these fea-
tures, type them one at a time
in the Ask @ Question box.

in the Name box changes

@E’i Dynamqle Music

from A2 to B3 (Figure 1-19).

b2 Fourth Quaiter Sales
o

active cell ~.|w T T T e S (-
reference in Name S !
box changes o BG ; reereer}

FIGURE 1-19




Type Boston in coll
":.: B g3,
Excel displays Boston in the
formula bar and in cell B3
(Figure 1-20}.

Press the RIGHT
Arrow key.

Excel enters the column title,
Boston, in cell B3 and makes
cell C3 the active cell
(Figure 1-21).

Repeat Steps 2 and
3 for the remaining
column titles in row 2. That
is, enfer Chicago in cell
€3, Denver in cell D3,
Phoenix in cell E3, and
Total In cell F3. Complete
the last entry in cell F3 by
clicking the Enter hox In
the formula bar.

The column titles display

.+ E1,20 o Project1 = Creafing o Worksheel and tmhedoea Lharl

Microsoft Excel - Bookt

_| Boston dlsplays
Bosto In formula bar
and cell B3

FIGURE 1-20

Typs & question for help

2 DynamlteMusm 3 ) i . ] ] 52

4Fourth Quarter Sales C3als USSR S :

5 - :
BOSlOHd} i, active cell ) SR momrrns 1 3

S : — e

colurnn -
(LTI

R T P PRI B 8 A S ook O B

FIGURE 1-21

Tvps & quastion For help
Looranarasinarsan,

& «‘ Dynamlte Musu:
725 Fourth Quarder Sales
Baston,

_JTotal

Text left- allgned
in cells

FIGURE 1-22

left-aligned as shown in Figure 1-22.

If the next entry is in an adjacent cell, use the arrow keys to complete the entry
in a cell. When you press an arrow key to complete an entry, the adjacent cell in the
direction of the arrow (up, down, left, or right) becomes the active cell. If the next
entry is in a non-adjacent cell, click the next cell in which you plan to enter data, or
click the Enter box or press the ENTER key and then click the appropriate cell for the
next entry.

Entering Row Titles

The next step in developing the worksheet in Project 1 is to enter the row titles
in column A. This process is similar to entering the column titles and is described in
the following steps.
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23 To Enter Row Titles

Click cell A4. Type
Cassettes and
then press the pown ArRrROW
key.

N ed
4EE T

row tille entered |2
Sl incalt Ad :

s

Excel enters the row title,
Cassettes, in cell A4, and
cell A5 becomes the active
cell (Figure 1-23).

" iChicage
-1 As is ,,,,,,,,,,,,,,,,,,, B L Tt PP
- active cell ] -

Repeat Step 1 for
the remaining row
fitles in column A. Enter
Compact Discs In cell AS,

Vintage Vinyls in cell A :
A8, Web Downloads incell  fhyfyimiatiee
r 25| Fourth Quarter Sales
A7, and Total in cell A8, / {Boston_ {Chicage |Denver _ Phosnix_ {Total

|Casseltes
i|Compact Discs

i i row titles
The row titles display as s ow ltlec

shown in Figure 1-24. ' {#eh Dowr ; ! B

FIGURE 1-24

In Excel, text is left-aligned in a cell unless you change it by realigning it. Excel
treats any combination of numbers, spaces, and nonnumeric characters as text. For
example, the following entries are text:

401AX21, 921-231, 619 321, 883XT1Y

e )
TR AT

gntering Numbers Cassettes 53465.30 31913.75 62350.10
. Compact Discs 92023.75 70392.10 B6140.55 8345075

In Excel, you can enter numbers into cells to . .
represent amounts. Numbers can contain only Yintage Vinyls 35482.56 30976.25 48612.75 34092.75
the following characters: Weh Downlonds 78526.12 67626.60 67420.20 56732.80

0123456789+-(),/.$%Ee

If a cell entry contains any other keyboard character (including spaces), Excel
interprets the entry as text and treats it accordingly. The use of the special characters
is explained when they are used in the project.

In Project 1, the Dynamite Music Fourth Quarter numbers are summarized to
the right in Table 1-1, These numbers, which represent fourth quarter sales for cach
of the stores and product groups, must be entered in rows 4, §, 6, and 7. Perform the
steps on the next page to enter these values one row at a time.
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1

Séeps To Enter Numeric D

Click cell B4. Type
¥ 53465,30 and then
press the RIGHT ARROW key.

det w
mﬂ@l@&ﬂxhﬁ @ln o |@2~

yp# A question for help

<o HIUl s3Eis %, R °8|t§t§ 1
; C4 - 1
|nsngn|1|canl zero
Excel enters the number KT ok ikaspey 5 T E T F TG T A
5346530 n CE?” B4 ond |_1_|Dynamite dMuysic ;
h . i I |2 [Fourth Quarter Salss N :
changes fhe achive cell 1o ce ER Boston E%jﬂenver Phoenlx Tulal
C4 (Figure 1-25). Excel does %-82?““’;%@3@53 U e
. A | & |Compact Discs : :
not display the insignificant 6 [vintago Vinyis - Aetveoel:
. | 7 |Web Downloads | 53465.30
zero. The zero will reappear ol | amoreiin
when the numbers are for- Eng B4 1

matted with dolfar signs and b
commas later in this project.

FIGURE 1-25

Enter 47917.35 in E3Miciosolt Excel - Booki’ . i FRERE
cell €4, 31913.75 ‘[@] Flo~ Edt View Insert Foymst Tuuls Qata Wlndnw Help
I k)

iy, Type 4 question for help ~

BHIBGRYI I BB T - n-!gz-hwlmamo% o
inceI:D4,und 62350.10 ;Ma. 0B 2w g.$/j @l e A
in cel E4. Ed - £ 623801

A 78 T ¢ | o e F | & [T H_ | 1 70 ] K

i 1_|Dynamite Music

| 2 {Fourth Quarter Jales

3 Boston  Chicage Denver  Phoenix  Total
47 |Cassoltes 53485.3 479]7 35 3193 75' [1‘2350.1!

5 |Compacl Diges B o

Row 4 now contains the
fourth quarler sales by store
for the product group

Cussettes (Figure 1.26). (G [Vintage Vinyls T LT
. ,..LVVEb Downloads | aumbers right- -

The numbers in row 4 are 5 Total " aligned in célls :
9 . - P .

right-aligned, which means | 9 |
Excel displays the cell entry ;
to the far right in the cell.

FIGURE 1-26

Click cell BS. Enter

“'le femainlng fOUlih ,Ifglj Bl E;dx;fp\,{g ésa‘ ;Tz; [;;al;‘j Qaf; I* dow ﬂel;l:\%. '“Ai iil e é;eaquestmnfm help |
) e O b 0% v v o
quarter sales provided in : | {
T bl I ] “I I iArial ',Em iﬂl’ Hl%%. !$%) i °8!€Fi?[_'@' é,
able 1-1 on the previous T
page for each of the throe A 1 B [ ¢ [ b FrEST Fol & o [ T T I TR L
d | 1 |Oynamite Music i
remul“'“g P'o “c| g'oups P_2_Fuuﬂ|1 Quaiter Saies
R b 3| Bosten  Chicago  Denver  Pheenix  Total
in rows 5, 6, and 7 | 4 |Caseslles 53653 4791735 3191575 622401 _ :
. 6 jCompact L 5202375 703021 8614055 8345075 data entered
The fourth quarter sales dis- 6 {Vintage Vi 3545256 30976.25 4561275 3409275 o workshest
cor T fweb D 76266 657420.2]_ 567324 o
play as shown in Figure 1.7, ﬁmeal ovAGVE526.12 676286 574202 ]
. ]
fie e
row titles 5
' parlially display
S FIGURE 1-27
a
Entering Numbers
us Text
There are times when you will
wani Excel lo treat numbers, As you can see in Figure 1-27, when you enter data into the cell in column B, the
such as zip cades and tele- row titles in column A partially display. Later when the worksheet is formarted, the

phone numbers, as text. To
enter a number as text, start the
entry with an aposirophe ().

row titles will display in their entirety.
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Steps 1 through 3 complete the numeric entries. You are not required to type
" dollar signs, commas, or trailing zeros. As shown in Figure 1-27, trailing zeros do
not display. When you enter a number that has cents, however, you must add the
decimal point and the numbers representing the cents when you enter the number.
Later in this project, dollar signs, commas, and trailing zeros will be added to
improve the appearance and readability of the numbers.

be!wee'n'.'dppl "xim'd'tél-y' _
1% 19308 and 1 % }0303

aICUIatlng a Sum ' : ' That's ¢ hegahve T followed
. ' o _ : by 308 Zergs or. o positive T
The next step in creating the worksheet is to determine the total fourth quarter sales followed by.308 zeres. To
for the Boston store in column B. To calculate this value in cell B8, Excel must add ;";eor a numbsr'such'as -
the numbers in cells B4, BS, B6, and B7. Excel’s SUM functien provides a convenient 0,000,000,000.you e
. . . type it as shown or you.tdn
means to accomplish this task. type 7.5€12, which stands for
To use the SUM function, first you must identify the cell in which the sum will 7.5 %1012,

be stored after it is calculated. Then, you can use the AutoSum button on the Standard
toolbar to enter the SUM function as shown in the following steps.

Sff‘pb To Sumt a Column of Numbers

AutoSum
button

CHCI( CO" B8 and [ Micrasolt Excel - Ropk1
_then point fo the
AutoSum button on the
Standard toolbar.

Cell B8 becomes the active Dynamite Music

, Fourth Quarier Sales
CE” (FJQUfe ]‘28) Boston E"I{Eago Denver __{Phoenix
A 53465.3] 47917.35 31913 75 623501
92023.75] 70392.1] 8614055 ¢

35457 86| 0976251 4861275
766 13) 6066 674202| 667328

{ . S
~! B8 is

active cell

FIGURE 1.-28

lf 2 Click the AutoSum
' button.

Excel responds by displaying
=SUM(B4:B7) in the formula

. . il
bar and in the active cell B8 S Dynamile Music
, . rter Sales .
(F'gure ]'29) AScreenTJp Boston__ {Chicago |Denver Phoenix
displays below the active cell. E3465.3) 47017.35] 31913.75, 623501
o Com G3025.75)_ 70392.1] 86140,55] B30.75]

The B4:B7 within parentheses inkelia | 35482 6 30076 25| AB612.75] 34002 75

, A i _ 67402 567328
fOHOWH‘Jg the IEUHC« praposed range to _?3;51 2768 BrA0.2 -
: . sum surrcunded by b = - _SUM f\,!ncucn ,,,,,,,, e A
tion nome SUM is MANes SoMuimbert, rmber2l, ) | 1] displays in aclive

i N Tk I
Excel’s way of identi- FE - N RN e
fying the calls B4 through B7. B screentip lf
44 H

Excel also surrounds the pro-
_ posed cells fo sum with o mov-

ing border; called @ marquee. , | FIGURE 1-29




8 Click the AutoSum
- button a second

time..

" Excel enters the sum of the
fourth quarter sales in cell B8
(Figure 1-30). The SUM func-
tion assigned to cell B8 dis-
plays in the formula bar when
cell B8 is the active cell,

LAY T BRIV 1 T RIRUTH Y W OVTDERadduol UG Cindedded Chuls

1. Click Insert Function button
- in formula-bar, select SUM
in Select a funclion list, click
- OK button, select range,
click' OK button

"2, On Insert meny click
_Function, select SUM in
~Select.a-funclion list, c_l_ick
< OK button, select rangs,

click OK bution

3. Press AIF+EQUAL SIGN (=)

“ hwice h

-4."In Yoice Command mode

say, “AutoSum, Sum, Enter”

AutoSurm button
arrow provides access

SUM function to other often used
} assigned to active cell functions

0 -.- 88in formula bar i . L [ _

] ; Type a question Far help ~ 6, 4

¥ ; % % s Vil EASY ) i ; |
g : s Rl il g‘ i 1 100% i ; -
e fhaiakia % ™y & St $pd 43 53 Bt T 4 : 3 % .
10 ; e ¥ il ; ;
A.gimmum 2 O A o d!fi‘?ﬁ ,*?"‘E’ ? it £
BE =SUM(B4:E7) :
LR R A B A R e e e (:

Dynamite Music B ) 3 i
Fourth Quarter Sales j l
s Boston _ iChicago [Derwer _IPhosnix_jTotal | ;
MEiCassattes| 53466.3] 47917.35] 31913.75¢ 62360 1 3 ) 3
tCompact [ 92023 78] 70392 1) 86140551 #5450.76 " l

61 Vintage Vil 35452 56 30575051 48612,75| 34002.75]
: 7857612 67420.2| 567326
759497 7,

P

sum of numbers

R
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FIGURE 1-30

When you enter the SUM function using the AutoSum button, Excel
automatically selects what it considers to be your choice of the group of cells _
to sum. The group of adjacent cells B4, BS, B6, and B7 is called a range. A range

- 1s a series of two or more adjacent cells in a column or row or a rectangular group -

of cells, Many Excel operations, such as summing numbers, take place on a range
of cells. ' '
When proposing the range to sum, Excel first looks for a range of cells with

mumbers above the active cell and then to the left. If Excel proposes the wrong range, .

you can drag through the correct range anytime prior to clicking the AutoSum but-
ton a second time. You also can enter the cosrect range by typing the beginning cell
reference, a colon (:), and the ending cell reference.

If you click the AutoSum button arrow on the right side of the AutoSum button,
Excel displays a list of often used functions from which you can choose. The list
includes functions that allow you to determine the average, the minimum value, and
the maximum value of a range of numbers. :

sing the Fill Handle to Copy a Cell to Adjacent Cells

Excel also must calculate the totals for Chicago in cell C8, Denver in cell D8, and for
Phoenix in cell E8. Table 1-2 illustrates the similarities between the entry in cell B8
and the entries required for the totals in cells C8, D8, and ES.

To place the SUM functions in cells C8, D8, and E8, you can follow the same
steps shown previously in Figures 1-28 through 1-30. A second, more efficient
method is to copy the SUM function from cell B8 to the range C8:E8. The cell
being copied is called the source area or copy area. The range of cells receiving the
copy is called the destination area or paste area.

Although the SUM function entries are
similar in Table 1-2, they are not exact copies.
The range in each SUM function entry to the

i _ {9’,, ; right of cell B8 uses cell references that are one

Ba - =SUM(B4:B7) Sums cells B4, BS, 86, and B7 column to the right of the previous column. -

8 ~SUM(CA:C7) Sums cells C4, €5, C6, and (7 When you copy cell references, Excc-':llautomati-
cally adjusts them for each new position, result-

Dy =S-UM(D_4:D” Sums cells D4, D3, D6, and D7 ing in the SUM function entries illustrated in

1] '=SUM{F4:E7) Sums cells E4, E5, £6, and E7 Table 1-2. Each adjusted cell reference is called

a relative reference,
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The easiest way to copy the SUM formula from cell B8 to cells C8, D8, and E8
“is to use the fill handle. The fill handle is the small black square located in the lower-
right corner of the heavy border around the active cell. Perform the following steps
to use the fill handle to copy cell B8 to the adjacent cells C8:E8.

To Copy a Cell to Adjacent Cells in a Row

Steps

bl

With cell B8 active, aso oo ‘ e f1
point to the fill i - [0 Type 2 question for help_ BIGLI

S

handle.

The mouse pointer changes
to a cross hair (Figure 1-31).

N Boston  [Chicago |Denver  1Phoenix_Total | ) T a8
T[Cassalies] 53465.3] 47917.35] 3191375, 623501 - T el
Compact & 92023.76] 70392.1! 86140.55} 83450.75
Vintage Vi

35467 55| 30076.25] 48612.75! 34092.75

vl 78526.121 67420.2] 567328
25049771 -
cross hair  poopoooeer
indicates fill

handle is salected bt e e ST S

ity 4 f £
A Y B P M R AR N SN R PR P PR T L d et K ot

FIGURE 1-31

Drag the fill
handle to select
the destinalion areq,

range C8:E8. -
Excel displays a shaded | Oynamite Music | o
, . . rter Sales * -
border around the destination R i st i sl ] %5 dogeing okos plac,
DT R rr ey AT e R - YS a boraer
areq, range C8E8, and RO 113,75 ﬁﬁigj ! around destiration area
Jrpact L : ! . and source area
the source areq, cell B8 Eafvintage Vi 56| 30976, 25 Shuoo 751 alioha
. 76575 131 6I676.6 2 GerRa S
(Figure 1-32). 5 SRtk & mouse
Eﬁg A pointer
SOurce area |-

{coll B8} |_....I destination
asea (range

FIGURE 1-32
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P Release the mouse
butson.

Excel copies the SUM
function in cell B8 to the
range C8:£8 (Figure 1-33).
In addifion, Excel calculates
the sums and enters fhe
results in cells C8, D8, and
E8. The Aufo Fill Options but-
ton displays to the right and
below the destination area.

- 1. Select source area, on Edif
menu click Copy, select des-
tination-areq, on Edit menu
click Paste

2. Rightclick source area, click
Copy on shortcut meny,
rightclick destination area,
click. Paste on shortcut menu

3. Select source area-and point
to border of range; while
tiolding down the cirt key,
drag source area to destina-
tion area

4, Selact source areq, press
CTRL+C, select destination
dreq, press CIRL+V

5. Select source areq, in Voice
Command maode say, “Copy,
[select destination ared],
Paste”

ooy W Ui faiiv ol WL LITRBWRLE LT

2 ¥ o P i PO
R R O e e G

range BB:ES {lransparent

@@ Fourth Quarer Sales o _
Boston_ IChicago |Denver  {Phoenix |Total| . biue background)
e remains sefactad until

E,ﬂaﬁ Casseties| 534b6.4) 4791795 31913 75| 62350.1 ) act

V5] Compact ] 92023.75] 70302.1] 66140.55| 53460.75 angltier cell s selectad

267 Vinlage Vi| 35482 56| 3097626} 48617 75| 3408775 | I

Weh Oowr 78536 12| &/6266! 574202 Auto-Fill Options button

1260497 7§ remalns on screan uniil
5 - you begin next activity

- 'S
BT

77| Dynamite Music

"_] E4+E6+E6+E7 |

FIGURE 1-33

Once the copy is complete, Excel continues to display a heavy border and
transparent (blue) background around cells B8:E8. The heavy border and tranisparent
background indicate a selected range. Cell B8, the first cell in the range, does not dis-
play with the transparent background be cause it is the active cell. If you click any
cell, Excel will remove the heavy border and transparent background The heavy
border and transparent (blue) background is called see-through view.

When you copy one range to another, Excel displays an Auto Fill Options button
to the right and below the destination area (Figure 1-33). The Auto Fill Options button
allows you choose whether you want to copy the value in the price area with format-
ting, without formatting, or only copy the format, To list the selections, click the
Auto Fill Options button. The Auto Fill Options button disappears when you begin
another activity.

Determining Row Totals

The next step in building the worksheet is to determine totals for each product
group and total fourth quarter sales for the company in column E Use the SUM
function in the same manner as you did when the sales by store were totaled in row
8. In this example, however, all the rows will be totaled at the same time. The
following steps illustrate this process.
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To Determine Multiple Totals at the Same Time

Click cell F4.

CH F4 becomes the active
cell (Figure 1-34).

With the mouse
pointer in cell F4
and in the shape of a block
plus sign, drag the mouse
pointer down to cell F8.

Excel highlights the range
F4:F8 (Figure 1-35).

Click the AutoSum
button on the
Standard toolbar.

Excel assigns the appropriate
SUM functions to cell F4, F5,
Fé, F7, and F8, and then
calculates and displays the
sums in the respective cells
(Figure 1-36).

Select cell A9 1o
deselect the range

F4:F8.

F4 is
active cell i~ 7

703933
: 30976.26

mouse pointer is | T
a block plus sign |

..

= S dateD. SRR SR
7613 o range F4:FB’J

30976.25] 4 selected

spymsrTres

259497 .7

FIGURE 1-35

AutoSum
button

=SUM(B4:E4)

[543 Dynamite Music

Founh Quarter Sajs| L
_{Bosty Chicago

78526 12! B7626.6]
250497 71 216912,

.1 totals for each
row of numbers

ti}

FIGURE 1-36
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If each cell in the selected range is next to a row of numbers, Excel assigns the
SUM function to each cell in the selected range when you click the AatoSum button,
Thus, five SUM functions with different ranges were assigned to the selected range,
one for each row. This same procedure could have been used carlier to sum the
columns. That is, rather than selecting cell B8, clicking the AutoSum button twice,
and then copying the SUM function to the range C8:E8, you could have selected the
range B8:E8 and then clicked the AutoSum button once.

i F i Figure 1-36 i fo.

. the range’ (B4:F8).and -

. then-click the AutoSum button.

+  The rnge B4:F8 includes.the - The text, numeric entries, and functions for the worksheet now are complete. The

nuribers o sum plusan addi- next step is to format the worksheet. You format a worksheet to emphasize certain

= -tional row {row 8} 'and-an - . .

' addilional colomn (column Fl; entries and make the worksheet easier to read and understand.

. in which the tofals will display. Figure 1-37a shows the worksheet before formatting. Figure 1-37b shows the
S L worksheet after formatting. As you can see from the two figures, a worksheet that is

formatted not only is easier to read, but also looks more professional.

L §ormatting the Worksheet J

FMiciosalt
P

B B— _Dynamite Music

eiics| 53465 31 47917.35) 31913.76] 62360,11 195548 Fourth Quarter Sales L
92023.75 .15 86140.55! | . Boston Chicaga Denver FPhoenix Total

30976.25. 48612.75; 3400374 3 Casseltes 1§ 63455301 % 479173518 31,913,751 § 62.950,10 | 310564650 |
6762661 6742030 Compact Discs | 82003751 7638310 66,14055 | B3460.75 | 39200735
nlage Vingls | 3548780 | 3097695 | ABHIL76 | 3409275

1

i
eb Downlogds | 7852612 ] 67 626.601 6742020 6673200 | 27030672 ¢
Total $258,497.73 | $216,612,30 | $734,007 26 | $236,626.40 | $947 12368 |

(a) Before Fermatiing {b) After Formatting

FIGURE 1-37

worksheet in Figure 1-37b, the following tasks must be completed:

1. Bold, eniargé, and change the color of the worksheet titles in cells A1 and A2,
2. Center the worksheet titles in cells A1 and A2 across columns A through E

3. Format the body of the worksheet. The body of the worksheet, range A3:F8,
includes the column titles, row titles, and numbers. Formatting the body of
the worksheet results in numbers represented in a dollars-and-cents format,
dollar signs in the first row of numbers and the total row, underlining that
emphasizes portions of the worksheet, and modified column widths.

;
)
i
To change the unformatted worksheet in Figure 1-37a to the formatted i
|
|

The process required to format the worksheet is explained in the remainder of
this section. Although the format procedures will be carried out in the order
described above, you should be aware that you can make these format changes in
any order,
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Fonts, Font Color, Font Size, und Font Style

Characters that display on the screen are a specific shape, size, color, and style. The
font fype defines the appearance and shape of the letters, numbers, and special charac-
ters. The font size specifies the size of the characters on the screen. Font size is gauged
by a measurement system called points, A single point is about 1/72 of one inch in
height. Thus, a character with a point size of 10 is about 10/72 of one inch in height.

Font style indicates how the characters are formatted. Common font styles include
regular, bold, underlined, or italicized. The font also can display in a variety of colors.

When Excel begins, the preset font type for the entire workbook is Arial with a size

In general, use no more than

and style of 10-point regular black. Excel allows you to change the font characteristics :‘:c; tz‘rzﬁs;fmd font styles

in a single cell, a range of cells, the entire worksheet, or the entire workbook.

Bolding a Cell

You bold an entry in a cell to emphasize it or make it stand out from the rest of
the worksheet. Perform the following steps to bold the worksheet title in cell Al.

: .'i-‘eps‘ To Bold a Cell

Click cell A1 and 1
ihen point to the [ ' o
Bold button on the E{ive call
Formatting toolbar.

The ScreenTip displays
immediately befow the Bold
button to identify the function
of the button (Figure 1-38). FIGURE 1-38

i ] Bold button
Click the Bold § changss to transparent S8 i Al
blue background when |24
bution. active cell is bold |

Excel applies o bold format to
the worksheet title, Dynamite
Music (Figure 1-39).

................ —p

contents of call

Fourth Quarler Sales ;. ] o o
__iHoston _iChicago Deuver :Phoemx fTotgl ! ] o

At are bold 5
T e e A R e s R A S N T W R et FAM AN
FIGURE 1-39 .
e g
. . . - 1. On Format menu dlick Cells
When the active cell is bold, the Bold button on the Formatting toolbar displays C“r;k .?;,‘,:] ,GE 'lejicimBoid,
with a transparent blue background (Figure 1-39). Clicking the Bold button a second click OK button '
time removes the bold format. 2. Rightclick cell, dlick Formot

Cells on shortcut menu; click
' H Font tab, click Bold, click
Increasing the Font Size A _
3. Press CiRL+8 _
4. In Voice Commarid mode
say, “Bold”

Increasing the font size is the next step in formatting the worksheet title. You
increase the font size of a cell so the entry stands out and is easier to read. Perform
the steps on the next page to increase the font size of the worksheet title in cell Al
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To Increase the Font Size of a Cell Entry

currenl I'onl Size r“l_:“t“'é“’"
— ' of characters in ont size
: 1 With cell Al EX Miciosal, cell A1 box arrow
R i il h : ‘{vpaaquestinnfwhe!p
selected, click the SR N T e
Font Size box arrow on the el o % oS J E‘i o TR
Formatting toolbar and i g .., :
then point to 24 in the Font 1o TR SR R R O e T R T -
1osi i
Slzelist. 0000 |mppElelinusc 1 5 - : — . g8
‘ ‘ :6 Hoago lDsnver  {Phosnix [Tatal - . - ?i ‘
ize list displ 18 T017.36] 3191375 62350.1] 195646.5 el
The For'# S{ze list displays os M R e + —ig
shown in Figure 1-40. ; Z2et 1376 76! 46512.75] 34092.75] 1491643 1 o - Wil
ﬁ@; 7626.6] 67420.2| BE73281 27030571 ) Bl
35845771 216012.3] 234007 3] 236626.4] 9471737 ) T N il
£ " [ :
S R A R S gl
~ ) - SRR E— - i 3
: S
- S D S - gl
B} i o ) i o "“g | / 5
- e il
1 4
s {2 :
el
FIGURE 1-40

Click 24. The

font size of the
characters In the worksheet
title in cell Al increase
from 10 point to 24 point
(Figure 1.41).

“tont In actlvo -
cell (A1) is
D'Mlcmsoll Em:el Book 24 poml bold B
r ; 5 }Qﬁ‘ AT B

<=1 from 10 point
-| to 24 point

[mm changes

Chlcagu
47917.35

Denver

Phoenix

Total

3131375

62350.1

195646.5

B514066]

83450.75

3320072

48612.75

2340873

“B74202

34092, 75

56732.8

1491643

270305.7

936626.4

71337

1. On Formal menu click Cells,

* click Font tab; sstect font
sizé in Size box, click OK
button

2. Rightclick cell, click Format
Celfs on shortcut menu, click
Fonf tab; sslect font size in
Size hox, click OK button

3. InVoice Command mode
- say, “Font Size, [desired font
size]”

-

FIGURE 1-41

An alternative to clicking a font size in the Font Size list is to click the Font
Size box, type the font size, and then press the ENTER key With cell A1 selected
(Figure 1-41), the Font Size box shows the new font size 24 and the transparent
blue Bold button shows the active cell is bold.

Changing the Font Color of a Cell

The next step is to change the color of the font in cell A1 from black to violet.
Perform the following steps to change the color of the font.




| kaf, To Change the Font Color of a Cell

With cell Al
selected, click the
Font Color button arrow

on the Formatting toolbar.

Polnt to.the color Violet
(column 7, row 3) on the
Font Color palette.

The Font Color palette

£ Microsoft Excel - Baok1.

rermarring tne worksneel ® & lal

§ Font Color
button arrw clo

Font Coko

Baoston

Chicago

Denver

Phaenix

Total

534653

47917.35

813.75

62350.1

palstte

rore emmer e 4

r

font in aclive
celt M ls black cl

B 92023.75
36483 56

703921

86140.55

83450.75

332007.2

4861275

309275

R

1 desired
-1 font calor

displays (Figure 1-42). 0655

3i69123

7852612
2594977

b7420.2; f

567328
234007 3} 236620.4

271830567

Q7130

FIGURE 1-42

Click Violet.

Te font in the worksheet title
in cell Al changes from black
fo violet (Figure 1-43}.

Eﬁ@g’@wﬁ%mﬂ

H H font in active
| |Dynlamite Music-=|guns,)
[:221F ourth Quarter Saies| n
ELE 1Beston__|Chicago  {Denver
T 2iCasaelies| 534653 47917.35] 31913.76
| J6 Compact 1 82023.751 70393 11 86140.55 332007
Vlnlage Vi 36482.56 30976 251 4861275 34092.75
57 Weh Dowd /6506,12] B5/6255] 6/420.2] 567328
EEE i 750407 7 218912 3] 234087 3] 2306 4) SaT1 237 1

FIGURE 1-43

1. On Format menu, click Cells,
click Font tab, ¢lick Color
bution, select color, click OK
button

Right-click cell, click Format
Cells on shortcut menu, click
Font tab, click Color button,
select color, click OK bution

You can choose from 40 different font colors in the Font Color palette in
Figure 1-42. Your Font Color palette may have more or fewer colors, depending
on color settings of your operating system. When you choose a color, Excel changes
the Font Color button on the Formatting toolbar to the chosen color. Thus, to 2.
change the font color of the text in another cell to the same color, you need only
select the cell and click the Font Color button.

3. In Voice Command made
say, “Font Color, [desired
color]”

Centering the Worksheet Title across Columns

The final step in formatting the worksheet title is to center it across columns
A through E. Centering a worksheet title across the columns used in the body of
the worksheet improves the worksheet’s appearance. Perform the steps on the next
page to center the worksheet title.
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Lz To Center u Cell’s Contents across Columns ;

WIih cell A} RN ) Hic 1650t E K1 T _ngrigehilr}gn
selected, drag to | acie car 0 IGHE UG P
cell F1. Point to the TN RS : SVl
Merge and Center button
on the Formatting toolbar.

H

¢ | range ALF
Excel highlights the selected : i i _fg’,‘?‘g" § ‘l

cells (Figure i‘44) 3 n er _Phoenix Total
66,37 4731735 31913.75; 62350.1° 195646.5. ' _ o
4. jCompact T 9200375, 70392 1 86140.65 Jdmz2. L !
FB [vintage Vit 35482 ; '

on Formatiing toolbar
idonlify formats assigned !
to active cell

Click the Merge
and Center button.

[
i

Excel merges the cells Al
through F1 fo creole o new
cell Al and centers the .
conlents of cell Al across .~

- ]r "Celis A1 through Fi

Dynamite Music
- are merged lo create |

Fourth Quarter Sales e S new cefl A1 !

columns A e £ Bl ‘BostonChicagn Depver  Phosnix  Total T
i hE contents of cel D iCasseltes 534853 47917.35. 3191375 623601 1966465 7 -
woug Al centered across | F 5 fcompact € 9202375 703921 85140.55. B3450.75, 3320072

(Figure 1-45). | columns A through ¢ | [~ Vintage Vi 35482.55° 30076.25: 4861275 3409275 1491643
|Web Dowr 7852612 Gie2EE 674202 567328 270305 7.
After the merge, cells Bl §Tatal 250497 7 2IBSI23 2340673 2386254 9471237

through F1 no longer exist
on the worksheet.

i a ;
i heavy border indicates !
I new dimensions of cell |

0

FIGURE 1-45

1. On Format menu click Cells,

click Alignment tab, select Excel not only centers the worksheet title across the range A1:F1, but it also

Center Across Selection in merges cells Al through F1 into one cell, cell A1. The alternative to merging cells
Eorizomal fist, click OK is splitting a cell. You split a merged cell by selecting it and clicking the Merge and
viton

vion ' Center button. For example, if you click the Merge and Center button a second time
2. Rightclick cell, click Format in Step 2, it will change cell Al to cells A1, B1, C1, D1, E1, and F1. For the Merge

Cells on shorteut , )
lecks Align:e:ru Imee:leJIecf and Center button to work properly, all the cells except the lefemost cell in the range

Cenfer Across Selection in of cells must be empty.

Horizontal list, click Most formats assigned to a cell will display on the Formatting toolbar when the

OK button : cell is selected. For example, with cell A1 selected in Figure 1-45 the font type and
3. In Voice Command mode font size display in their appropriate boxes. Transparent blue buttons indicate an

“pA d " i . ; 3 i i
say, “Merge and Center assigned format. To determine if less frequently used formats are assigned to a cell,

point to the cell and right-click. Next, click Format Cells, and then click each of the
tabs in the Format Cells dialog box.

Formatting the Worksheet Subtitle

The worksheet subtitle in cell A2 is to be formatted the same as the worksheet
title in cell A1, except that the font size should be 16 rather than 24. Perform the
following steps to format the worksheet subtitle in cell A2.

="



buttons and boxes on
Formatting toolbar
Identify formals assigned
to active cell A2

10 FORMAT THE WORKSHEET
- SUBTITLE

m Select cell A2,
Click the Bold button

rormaizing ine worKsneer ® k133

on the Formatting
toolbar.

Dynamlte Musnc
Fourth Quarter Sales

Boston | Denver . |Phoenix

Click the Font
Size arrow on the

Tolal

Font Color button
is violet because

violst was last color |

selected

856465

53465.3 3193761

47917.35

Formatting toolbar

....... i

302375 65140, 551 3450 75
it 3548266 48612.75] 34092.75
78526.12 67420.2] 56732.8

703921
30976.25
B76J6 b

30072
1431843
27030571

and click 16.
Click the Font Color

and merged

16-peint vialet
bold with text centerad

TUIRA97 71 16912 31 234087, 3] 256626.4] 9471071

' ~ button.

Select the range
A2:F2 and then click
the Merge and Center
button on the Formatting toolbar.

FIGURE 1-46

The worksheet subtitle in cell A2 display as shown in Figure 1-46.

With cell A2 selected, the buttons and boxes on the Formatting toolbar describe
the primary formats assigned to cell A2. The steps used to format the worksheet sub-
title in cell A2 were the same as the steps used to assign the formats to the worksheet
title in cell A1, except for assigning the font color. To color the worksheet title font
in cell A1 violet, the Font Color arrow and Font Color palette were used. To color
the worksheet subtitle in cell A2 violet, the Font Color button was used. Recall that
the Font Color button is assigned the last font color used, which was violet.

Using AutoFormat to Format the Body of a Worksheet

Exce] has several customized format styles called table formats that allow you
to format the body of the worksheet. Using table formats can give your worksheet a
professional appearance. Follow these steps to format the range A3:F8 automatically
using the AutoFormat command on the Format menu.

f

To Use AutoFormat to Format the Body of a Worksheet

Stc S

Select cell A3, the
upper-left corner
cell of the rectangular
range o format. Drag

ype & question for help
(37

upperdeft : heavy border and

ihe mouse poilliel' to bhue background

corner cell of
range to iormal

deﬁnas range

coll F8, the lower-right
corner cell of the range

to format.

Excel highlights the range

(A3:FB)

“frange to format|_

to format with a heavy
border and transparent blue
background (Figure 1-47).

FIGURE 1-47
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Format |
: menu name |
; on menu bar |

Click Format on the
menu bar and then
point to AvtoFormat.

Format

et view

R L
Format
menu

I5* -Daty Wlnduw l;{elp Type avueshen forhelp « . L X
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Column »

The Format menu displays
(Figure 1-48).

sheet B34 MY I R a

AutoFormal nr

command

FIGURE 1-48

Click AutoFormat. “autoFormal | | Question -

' Click ihe Accouniing 7 _ B dialeg hox‘ i,ata S LMark bu‘l_lf)m
1 format in the AvtoFormat © 8 ﬁf@ @ v f}/ Ba- <>’s T ':@ = -1 OKkbuton | 1% - EE) !
: rid - . &, Al :
dialog box. Poini to the OK | ™™ :

bution.
. 1 8 . - o -
The AUfOFOmef OIFC‘IOQ - v 6 4 7 A7 ‘ —'A.'«-_; Close buuon ar Cancel
. . . o 8 7 3 M button exits AutoFormat

box displays with « list ToRgl 21 T3 3 ko NS ER I J gptions..._| ! dialog box withaul making
of customized formats Classic 2 Clossk 3 /t\ . changes
{Fjgufe I-4 9) EOCh form(}f s Sat Aae Towi | dan  Felx ar Tola) ‘ .0p|io'n«s:,”i
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the worksheet wi ispiay A9 siATeui § A3 165 31 % 60| [Tl 5 P30 550
T - 10 ! Ascounting | F
H( ifis ChOSE?n. TN o s;‘églg‘g i Accourting 1 ‘ ficcgunting 2

I e KT ¥ P Jan _Feb  Mar Toul dan_ Feb fdar Total

! range AZ:A8 EEl EiSt S 7% 75 5519 [Bast § 7% 7§ &4 19

will be affected by b7 West B 4 7 17 bwast 6 4 7 47 7
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FIGURE 1-49

Click the OK button.

seleCi cell 410 1o ,@ Fle  Ede  vew J_nsert Format  Took Data  Window Ty
H 5 Qﬂ-mv' - P 100% -
deselect the range A3:F8. FHANSBRYs wm- iR E NS @.
i avial - 10 '[BI!J,EEE<$AJ.03+?3‘§F!?‘_.;'&‘£'
Excel displays the worksheet g U, =7 L O B N - SOt By B S T = :
with the range A3:F8 using R - . - s
h rod £ 1 Dynamite Music
the customized format, ]
Accounting T {Figure 1-50). 2. Fourth Quarter Sales ,
3 Hoston Chicage Denver Phoense Tolal -
i [Casseltos $S3AGEI0E 451735 § 300376 § G2w000 WL
|5 Compact Discs 9202375 7038210 64065 8345075 300715 range AGES)
6 [Vintage Vinyls 3548266 2097625  40B1276 00275 449,15431 ommatied -
[_{Web Dowrloads 7850512 E7E2580 6742020 6673280 21030672
8 [Tota] 294773 $2159¢230 5234 087 35 _1296.506.40 9712567 |
T
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12,
i3
-
1. Press am+o, A FIGURE 1-50

2. In Voice Command mode
say, “Format, AutoFormat,
Idesired AutoFormal], OK*
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The formats associated with Accounting 1 include bold, italic, right-aligned
column titles; numbers displayed as dollars and cents with comma separators;
numbers aligned on the decimal point; dollar signs in the first row of numbers
and in the total row; and top and bottom rows display with borders. The width
" of column A also has been increased so the longest row title in cell A7, Web
Downloads, just fits in the column. The widths of columns B through F have
been increased so that the formatted numbers will fit in the cells.

The AutoFormat dialog box shown in Figure 1-49 includes 17 table formats and
five buttons. Use the vertical scroll bar in the dialog box to view the 11 table formats
that do not display. Each one of these table formats offers a different look. The one
you choose depends on the worksheet you are creating. The last table format in the
list, called None, removes all formats,

The five buttons in the dialog box allow you to cancel, complete the entries,
get Help, and adjust a customized format. The Close button terminates current activ-
ity without making changes. You also can use the Cancel button, immediately below
the OK button, for this purpose. Use the Question Mark butten, to obtain Help on any
box or button located in the dialog box. The Options button allows you to select
additional formats to assign as part of the selected customized format.

The worksheet now is complete. The next step is to chart the fourth quarter sales
for the four product groups by store. To create the chart, you must select the cell in
the upper-left corner of the range to chart {cell A3). Rather than clicking cell A3 to
select it, the next section describes how to usc the Name box to select the cell.

ing the Name Box to Select a Cell

The Name box is located on the left side of the formula bar. To select any cell, click
the Name box and enter the cell reference of the cell you want to select. Perform the
following steps to select cell A3,

Click the Name box
in the formula bar.
Type a3 In the Name box.

Even though cell A10 is the

“Merging Table

Formats

It is not uncommon to apply
two or more of the table for-
mdits in Figure 149 to the
same range. If you assign two
table formats Io a range, Excel
does not remove the original
format from the range; it sim-
ply adds the second table for-
mat io the first. Thus, if you
decide to change a table for-
mat fo another, select the table

* format None from the boltom

of the list to clear the first table
formiat.

e e e
Typa a quastion for help
ey :

active cell, the Nume box .

" Dynamite Music

displays the typed cell a3 typed in

Fourth Quarter Sales

f 3 F T 5] Name box
rererence a ( Igure 1- ) ' : Boston Chicago Denver Phoanix Total

-

§ 5346530 1§ 47,017.35 1 § 31,914,751 § 62,350.10 | $105646.50

ompact Discs | 92023751 70,392.10 T B34E0 75| 33200715

ABB1275

intage Vinyls & 3546256 |  300/6.26 34092757 149 18431

e Downioads | 78,526.12 660 | B7 420201 56,732.80 1 270,306.72

67 526.60
$259.497 73 | $216.912.30 | §234 087 25 | $236 626.40 | $347,123.68

Tolal

AlQig [T

e active celt |-

FIGURE 1-51
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Press the nter key.

xcef changes the active cell
from cell A10 to cell A3
(Figure 1-52).

ynamite Music

' Azis
i aclive cell R
]

Fourth Qi

marter Sales 7

FIGURE 1-52

S - As you will see in later projects, besides using the Name box to select any cell
: in a worksheet, you also can use it to assign names to a cell or range of cells.
& Morelflou:: .y g g

Naming Cells
and Ranges

If you repeatedly select certain

cells in a worksheet, consider
naming the cells in the Name
box, Selact the cells one at a

Excel supports several additional ways to s
" Table 1-3.

elect a cell, as summarized in

time and then type in g name
in the Nome-bz)? for each, Selocts the cell ono window to the right and moves the window eccordingly,
such as Company Totaf for cell ALT+PAGE UP Selects the coll one window to the left und moves the window accordingly.
F8 in Figure 1-52. Then, when
you wanf to select one of the ARROW Selects the adjacent coll in the direciion of the arrow on the key,
ggxmz(igir: ni}'?éeﬂ:i,::f '::; (TRL+ARROW Selocts the border cell of the workshoel in combinaifon with the arrow keys and moves
cell niame in the Name box the window accordingly, For example, to select the rightmost call in the row that containg
list. You can also name ranges the active coll, press ctat+RIGHT Araow. You also can press the e key, releass it, and
the same way. then prass the arrow key to accomplish ths same tusk, ‘
CTRL+HOME

Selects cell AT or the cell one column and one row below and to the right of frozen fitfes
and moves the window accordingly.

. »
Navigation
For more information on
selecting cells that contain cer-
tain eniries, such as constants
or formulas, visit the Excel

Find command en Edit meny

Finds and selects o cell that contains spedific contents that you enter in the Find dialog
box. If necassury, Excel moves ihe window to display the coll. You can press suter+ss
or CRL+F to display the Find ditlog box.

F5 or Go To command
on Edit meny

Selocis the cell that corresponds to the cell reference you enier in the Go To dialog hox

and moves the window accordingly. You can press L6 o display the Go To dialog
hox.

HOME Selects the call af the beginning of the row that contains the active tell and moves the
2002 More About Web page window accordingly.
[scsite.com/ ex2002/
more.htm} and click Using Name box Selocts the call in the workhaok that torresponds to the cell reference you ender in the
Go To Special, Name box,
PAGE DOWN Selects tho cell down one window from the aclive cell ond moves ihe window accordingly.
PAGE P

Selects the call up one window from the active coll and moves the window tecordingly,

i
|
I
i
i
i
i
1
|
l
ﬁ
|
1
]
|
|
|
|
|
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! dding 2 3-D Column Chart to the Worksheet

| The 3-D Column chart in Figure 1-53 is called -
" an embedded chart because it is drawn on the !
same worksheet as the data.

Dynannté Music
Fourth Quarter Sales

For the Boston store, the light blue column é’% ool Giaga | ety Frioec| . Tolsl
) F5Casseiles § 5346530 | § 4701735 | 8 31013.75 | § 62,350.10 | §195,646.50
represents the fourth quarter sales for the 8 oract Discs | 9200375 70.392.10 | 86,14065 | 63 460,75 | 333 007 18

1861295 | 3409275 | 149,164 31

Cassettes product group ($53,465.30); the purple [piivintage Vinyls | 3548256 3097625

igHwob Downloads | 78596121 67 626.60 67420201 5573280 [ 270,305.72
column represents the fourth quarter sales for e Totar $250.457.73 | §16,512.90 | $234.067,25 | $7°6 526,40 | §947,123.68
Compact Discs ($92,023.75); the light yellow [ oD ol
%ﬁi olumn
column represents the fourth quarter sales for T s100,000.00 e Chart
Vintage Vinyls ($35,482.56); and the turquoise  [&  saomao
column represents the fourth quarter sales for ?E 950,000 00 “‘Casse““n_
Web Downloads ($78,526.12). For the stores ?I;é $40.000.00 7 :- ;E;qulna;;aectv inl;c:
Chicago, Denver, and Phoenix, the  ________Zk&ll 000000 § I I 1 Web Downloads| |-

columns follow the same color scheme | ©jimns develonad 15 Li 2 o M ) -
Boston  Chicago Denver  Phoenix I -

to represent the comparable fourth | werksheet \ e
quarter sales. The totals from the 'm" dasn | ] ol ol
worksheet are not represented because the totals Y i represents 2ero g
were not in the range specified for charting.

Excel derives the scale along the vertical axis
{also called the y-axis or value axis) of the chart
on the basis of the values in the worksheet. For
example, no value in the range B4:E7 is less than
zero or greater than $100,000.00. Fxcel also determines the $20,000.00 increments
along the y-axis automatically. The format used by Excel for the numbers along the
y-axis includes representing zero {0) with a dash (Figure 1-53).

With the range to chart selected, you click the Chart Wizard button on the
Standard toolbar to initiate drawing the chart. The area on the worksheet where
the chart displays is called the chart location. The chart location is the range
A10:F20, immediately below the worksheet data.

Follow the steps below to draw a 3-D Column chart that compares the fourth
quarter sales by product group for the four stores.

_ represents a row [,
G in worksheet &
A ——

FIGURE 1-53

Steps _

To Add o 3-D Column Chert te the Worksheet

Chast
Wizard butlon

1 With cell A3
solected, position
the block plus sign mouse
pointer within the cell’s
border and drag the mouse
pointer to the lower-right

Dynmite Mus'i;({:

corner coll {cell E7) of the ! Fourth Quarter Sales

range to chart (A3:E7). T i T, R T
Point to the Chart Wizard < [ ' o e rngo poer -
button on the Standard Vitue vl 2 gse L SRR o -'-t%ﬁ'mg;;iw"

toolbar. Poiros___ $25949773 $947 123,60

Excel highlights the range fo o o e
chort (ngure 1-54} FIGURE 1-54

———————
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Click the Chart
Wizard bufton.

The Chart Wizard - Step T of

4 - Chart Type dialog box
displays.

%3 With Column
selected in the
Chart type list, click the

i

3-D Column chart sub-type

{column 1, row 2} in the
Chart sub-type area.
Point to the Finish
button,

Column is highlighted in
the Chart type list and
Clustered column with a
3-D visual effect is
highlighted in the Chart

sub-type area (Figure 1-55).

Click the Finish
button. If the chart
toolbar displays, click its
Close button. When the
chart displays, point to
an open area in the
lower-right section of

the Chart Area so the
ScreenTip, Chart Area,
displays.

Excel draws the 3-D
Clustered column chart
(Figure 1-56). The chart
displays in the middle of
the window in a selection
rectangle. The small
sizing handles ot the
corners and along the
sides of the selection
rectangle indicate the
chart is selected.

o Lredarnng a yvoriksheut Uid tmoeaded Lnart

ChartWizard - Step 1

Chart Wizard
button

".of 4 - Chart Type

i[{ button shows sample [~
of chart based on
2¢lected range and

chatt characteristics {..

Finish
button

- dlalog box
’ i1 ;
i TR e[ ol
10 & p 1 of 4
: $5)I.f‘:&}::—:ﬁ:i?n‘m;m" v ’d i & ’
Al s
i ‘Calumn §
SO “chart type [ = Gor
2 g {3 Line i
4 O g P i
L IS ;XY {Seatter) !
B I=Clif4 gy Area E
_ 3982 @ ooughnut )
el i @y Radar i
I Total 8263 497 01130 sntace o l ;
j—{jw B #3- Bubble el | B
b charls from [l Stff,lfm--vv\:w-'f— '@j S <E 5 e
range  L..fwhich 10 choose ww! z
to chart . :f Clustered column [f | ¢
S : | chart with a 3-D 3 et
1)/ * visual effect 4 {5
. Microsoft Excel |.... 1 i SRR e
i Help button [ =ik SNIEE : 135 8
E}m A A LEG ¥ 23 13 ¥
23
o

£ Microso

ft Excel - Bookt

when chart is

selectad, colored
borders in worksheet
indicates chart range |-~

Fourth Quarter Sales

Boslon | Chicago

A3 6346530 (§ 4727 351§ 3191375]5 62 350,

Total
10 ] § 195 546 50

9209378

35,482.56

1852612
$260497.73

sizing

$100,000.00
%530,000.00

$60,000.00

handles

$40,000.00¢
$20,000.00

TR
i

11
i

Bostan

Denver

initial 3-D

Clustered
"1 column chart [~

Casselles

@ Compact Discs
OVintage Vinyls -
0Web Downloads

mouse pointer
pointing to
Chart A

FIGURE 1-56

R g

o e

TS TS MR T, T

S

T
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Drag the chart down AL o1 @l = DO e SO

Bosion Chicagy | Denver Phoenix]  Total
and fo the left to § 5340530 |5 47 017.95 18 3191305615 52,350.101 §195,646.50 | N
_ i

position the upper-left 9107375

il 8
b5 Vintage meis 35,482 56
corner of the dotted line 572 1\Web Downloads | 7852612 |  $100,000.00

rectangle over the upper- fots) S2RANT3 :2333333 K & Cassellos
left corner of cell A10 " 44000000 B Cornpact Discs | ™1™~ -

OVintage Vinyls
tWeb Downloads| | ...

(Figure 1-57).

upper-left corner of $20,000.00

new chart location
over cell A10

Bosten Deriver

Excel displays a dotted line ] e . ‘ !

rectangle showing the new
chart location. As you drag
the selected chart, the mouse
pointer changes fo @ cross
hair with four arrowheads.

......... 1 - -
dofted line [ jrremr e
reckangle shows |4
new chart location |__.. ST

mouse pointer
changes to cross hair
with four arrowheads |,

Release the mouse

'B"\flnyls

button. Polint to the Web Downloads | 78 596,12 | 67.625.60 420, EB7200)
middle sizing handle on Total $216,012.30  $254 067 26 | $236 526,40 | §947,123.68
the right
dge of the [ oo [t e

edge o the of chart area moved $100 000.00 153 e Oatwo Iarrg\\?he:ags

| “0|'I to upper-left corner §50,000.00 ’
selec of call ATO - . 5 |mCasselles
l'ﬂdﬂllgle- ¥60.000.00 1] ol w Compact Discs “};f

- 1. N 75 ‘Hil . . - Sty
| MD'DUU'UE ; E 4 F’ _ E O'vintage Vinyls {Chart Area|
$20,000.0 : O%eb Downloads

The chart displays in a new . _ i
location (Figure 1-58). The ; Boston Denver
mouse pointer changes to
a horizontal line with two
arrowheads when it points
to a sizing handle.

i 70,

Fdoiie | 3007635 4061276 306375 | 14906431, T

7842602 | 6762660 6742020 | £673280) 27030672
$250 497.73 | $216,912.30 ; § 294 087 25 | $236 526,40 | $947,123.40

While holding down
the aLT key, drag the
sizing handle to the right
edge of column F. Release
the mouse huiton.

$100,000.00 s
$60,000.00
$60,000.00
$40,000.00
$20,000.00

@ Casseties
m Compact Discs o
DVintage Yinyls
CWeb Downloads| | . N IS I

While you drag, the dotted
line rectangle shows the new
chart location (Figure 1-59).
Holding down the ALT key
while you drag a chart snaps
(afigns) the new border fo the
worksheet gridlines.

mouse pointer {
dragged to right ¢-

mouse
**** pointer

Busmn Denver

1

propased
width of charl

FIGURE 1-59
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If necessary, hold

* down the ar key
and drag the lower-middle
sizing handle down to the
hottom border of row 21,
Click cell H21 to deselect
the chart.

The new chart location
extends from the top of cell
Al0 to the bottom of

cell F21 (Figure 1-60).

1. On Insert menu click Chart
2. Press F11

3. In Voice Command maode
say, “Chort Wizard*

2T

Chart Types
You can change the
embedded 3D Column
chart to another type by
clicking the chart location
and clicking the Charl Type
bution arrow on the Chart
toclbar. You also can use the
Chan toolbar to format the
chart lo make it look more
prafessional. if the Chart tool-
bar does not display when
you click the chart, right-click
any teolbar and click Chart.

Soreating o wWorksiiee! anu tmnedded Lhart

i GBI My clpselt CFomat| o Todls Dste . Window. Hep. . . .
DERASAGRY L BB -Io o g -4 Hn

HETR

H21 v o e

0 s u|EEEE S %, AA[EE L HA -,

" Type & questian for help

4{3 1nno/°' -@, e e

AI‘BICiDIEIFIG

| e N

Dynamite Music

1
2 | Fourth Quarter Sales
3 Hoston Chicago Denver Phoenix Totai
| 4 |Cassnltes § 5346630 § 4721735 § 3191375 § 6235010 § 195 .646.60
| & [Compact Discs 92,023.76 7039210 86,140.55 8345075  332,0G7.16
6 j¥intage Vinyls 35 .482.55 3097625 48,612.76 3403275 149,164.31
Z-hilah Downloads 76,526.12 67,526.60 R7,420.210 56,732.80 M0 350572
y-axis $269.497.73 $216912.30 $234087.26 $236,526.40 £947 12368
automatically [ y i
sealed ! right side of chart |
e o] ‘-::.'\L-=i dragged to right
] (oo
13} 1 $60000.00 o
% . B Cassettes t legend :
15| % 60,0000 & Compact Discs |4~ defines columns ;
6] | $0000.00 oVintage Vingls [ fmehartarea |
% { $20000.00 0Web Downlosds
gl v e L : .
20 ] Boslon Chicago Denver Phoemx\,\
] -;l\
21 S I:-EL——!
| 22§ N N
K4y ¥ihsheetl {Sheat? £ Sheots 7 N, \J_t_l Y |
Ready . . boltom of chart area column tittes in selected |
1 Start o o I 2 Wi it Excd dragged to bottom range become x-axis r
I il {( & Jg msn -l ,:g border of row 21 e calegory labels TR

FIGURE 1-60

The embedded 3-D Column chart in Figure 1-60

compares the fourth quarter

sales for the four product groups within each store. It also allows you to compare

fourth quarter sales among the stores.

Excel automatically selects the entries in the topmost row of the range (row 3)
as the titles for the horizontal axis (also called the x-axis or category axis) and draws
a column for each of the 16 cells in the range containing numbers. The small box to

the right of the column chart in Figure 1-55 on page
legend identifies each bar in the chart. Excel automat

E 1.38 contains the legend. The
ically selects the leftmost col-

umn of the range (column A) as titles within the legend. As indicated earlier, it also

automatically scales the y-axis on the basis of the ma
chart range. :
Excel offers 14 different chart types (Figure 1-55

gnitude of the numbers in the

on page E 1.38). The default

chart type is the chart Excel draws if you click the Finish button in the first Chart

Wizard dialog box. When you install Excel on a com
the 2-D (two-dimensional) Column chart,

¥
R

o

Y aving a Workbook

puter, the default chart type is

While you are building a workbook, the computer stores it in memory. If the

computer is turned off or if you lose electrical power,
you must save on a floppy disk or hard disk any wor

the workbook is lost. Hence,
kbook that you will use later.

A saved workbook is referred to as a file. The following steps illustrate how to save
a workbook on a floppy disk in drive A using the Save button on the Standard

toolbar.




To Save o Workbook

With a floppy disk
in drive A, click the
Save bution on the
Standard toolbar.

The Save As dialog box
displays (Figure 1-61}.

The preset Save in folder

is Documents and Settings
(your Save in folder may be
different), the preset file
name is Bookl, and the
file type is Microsoft Excel
Workbook. The buttons on
the top and on the side are
used fo select folders and
change the display of file

names and other information.

Type Dynamite
Music 4th
Quarter Sales inthe
File name box. Point to
the Save in box arrow.

The new file name replaces
Book! in the File name text
box (Figure 1-62). A file
name can be up to 255
characters and can include
spaces.

Save

JUVING @ YrUTRDUUR

L 141

Save As
- dialog box

Boston

rvoseomarseis st

{°] Documents and Settings

Administrator
) all Users

default folder
displays in
Save in box

defauit file
narme automatically
" highlighted In File

name box

Save as
lype box

Chicago Derver Phoenix

Documerits and Settings

Boston

-1 Administrator / r

Save in
box arrow

new file
name entered

Chicago Denver Phoenix

FIGURE 1-62
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arrow and then
point to 3% Floppy (A:).

A list of available drives and

folders displays (Figure 1-63).

Click 3% Floppy (A:)
and then point to
the Save button in the
Save As dialog box.

Drive A becomes the selected
drive (Figure 1-64).

Click the Save in hox

T
- Documents and Settings el
[ Deskiop

o] My Computer
Hu[.r'

3% Floppy
{A:) selected

)
Daocuments and Settings
g OFFICED (05}
Compact Disc {E:)
My Network Places
8 FTP Locations
&) addiModify PP Locations

Bosgton

Chicago Denver Phoenix

FIGURE 1-63

divea [ a4 4 g

selected

these buttons
sefect folders or

most recentiy i

opened files change the display

T

comimioniy
used foldars

A )

- S

new T Save
ile nam
fito name button

T s A

R g

N

Boston Chicago Danver Phoenix

FIGURE 1-64




SUVIRY M BUTRUVER - R B

title bar displays
new workbook
file name

AL
inrosoft Excel v/Dynan'iilc Music 4th Guaites Sales

- Click the Save
button.

Excel saves the workbook

on the floppy disk in drive A
using the file name,
Dynamite Music 4th Quarter
Sales. Excel automatically
appends the extension .xIs to
the file name you enfered in
Step 2, which stands for Excel
workbook. Although the work-
book is saved on a floppy
disk, it also remains in mem-
ory and displays on the

Dynamite Music
Fourth Quarter Sales

Roston Ghicage Denver

§ 6346530 1§ 4799735 1§ 3191375
Gp03375 1 7038210} 66,140.55
T3 Af2hb 1 3007625 | 4BE1276

75526121 67 629560 | G7.420.20
§260.497.73 | $216912.30 | $234,087.25

Phoenix

$ 62,350.10
B83,450.75
3409275
66,732.80
$235,626.40

§ 106 545,50
142 (07,15
149,154 31
27030572

§o47,123.60

]

445 Cassetles
K88 Compact Discs
[Z5] Vintage Vinyls
75 \Web Downloads
207 Tolal

worksheet and embeddad chat
remain displayed on screen after
being saved to driva A using
fila name Dynamite Music
4th Quarter Sales

$100,000.00

@ Casselles

screen (Figure 1-65). The
new file name displays on
the title bar.

$60,000.00
$40,000.00 8

$20,000.00
§-

# Compact Discs
0 Vintage Vinyls
ryWeb Downloads

B

e

FIGURE 1-65

1. O‘n'F.il'e."ménu dlick Save As,
type file name, selekt drive
or kslder, ‘click OK buiton

. Press cTrues, type file name,
select drive or folder, click
OK butien

In Voice Command mode
say, “File, Save As, [type
desired file name], Save”

While Excel is saving the workbook, it momentarily changes the word Ready
on the status bar to Saving. It also displays a horizontal bar on the status bar
indicating the amount of the workbook saved. After the save operation is complete, 2
Excel changes the name of the workbook in the title bar from Book1 to Dynamite
Music 4th Quarter Sales (Figure 1-65).

The seven buttons at the top and to the right in the Save As dialog box in 3.
Figure 1-64 and their functions are summarized in Table 1-4.

When you click the Tools button in the Save As dialog box, a list displays.

The General Options command in the list allows
you to save a backup copy of the workbook,
create a password to limit access to the work-
book, and carry out other functions that are dis-
cussed later. Saving a backup workbook means
that each time you save a workbook, Excel
copies the current version of the workbook on

S IR
i#,_\(? i g

4
fives

Default File Location

. . ) . Up One Lovel - Displays contents of next level up folder
disk to a file with the same name, but with the P poy P
words, Backup of, appended to the front of the .
file name. In the case of a power failure or some Search the-Web Starts hrowser and displays search engine
other problem, use the backup version to restore
your work. - Delete Deletes selected file or folder

You also can use the General Options
command on the Tools list to assign a Password Creale New Yolder Creates new folder
to a workbook so others cannot open it. A pass-
word is case—sensmwe_a.nd can be up to 15 char- Viows Changes view of fils and folders
acters long. Case-sensitive means Excel can :
differentiate between uppercase and lowercase : ——

Tools Lisls commans to print or modify file

letters. If you assign a password and forget the
password, you cannot access the workbook.

names und folders
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The five buttons on the left of the Save As dialog box in Figure 1-64 on page
E 1.42 allow you to select frequently used folders. The History button displays a list
of shortcuts {pointers) to the most recently used files in a folder titled Recent. You
cannot save workbooks to the Recent folder,

il

Excel allows you fo save a
workbook in over 30 different
file formats. You choose the

-rinting a Worksheet

file format by clicking the Save Once you have created the worksheet, you might want to print it. A printed version
as fype box arrow at the bot- of the worksheet is called a hard copy or printout.

;?i'“u‘:i ”]“_363“;‘? A: ‘i'c'EIO]Q j’;)x You might want a printout for several reasons. First, to present the worksheet
M,%rosoﬂ Excol \?Vo?kboo,; s and chart to someone who does not have access to a computer, it must be in printed
the default file format. But you form. A printout, for example, can be handed out in a management meeting about
can, for example, save a fourth quarter sales. In addition, worksheets and charts often are kept for reference
workbook in Web Page format by people other than those who prepare them. In many cases, worksheets and charts
50 you can publish it to the . N .

World Wide Web. are printed and kept in binders for use by others. Perform the following steps to

print the worksheet.

= Print [

button

Ready the printer
according to the
printer instructions. Point ot
to the Print buiton on I TS T
the Standard toolbar
(Figure 1-66).

FIGURE 1-66

Click the Print P T
* button. When the ;
printer stops printing the :
worksheet and the chart,
retrieve the printout.

| Dynamite Music
j; ' Fourth Quarter Sales

i Boston Chicago Denver Phoenix Totat

Casseflas $ 5346530 $ 4791735 § al 91376 $§ 62,350.10 §$195,846.50

N Compact Discs 92,023.75 70,362.10 66,140.55 83,450.75 332,007.15
Excel sends the wor ksheet Vintage Vinyls 3548256  30,97625 4861275 3400275 14916431
o fhe pn’n{er, which pn'n s ; Waeb Downloads 78,526.12 87,626.60 67,420.20 56,732.80  270,305,72

Tolal

$289,497.73  $216,912.30 $234,087.25 $238,626.40, $047,123.68

it (Figure 1-67).

i L $100,000.00

1. On File menu click Print,
click OK button

2. Rightclick workbook Control- ‘
menu icon on menu bar,

click Print on shortcut menu, -
click OK buiton

3. Press CTRL+P, click OK bulon FIGURE 1-67

. $80,000.00
: : Casselles

: 60,000. i
! $ 0 Compact Discs

E $40,000.00 Vintage Vinyls

E $20,000.00 [IWeb Downloads; :

4. In Voice Command mode
sary, "Print”




Prior to clicking the Print button, you can select which columuns and rows in the
44workshect to print. The range of cells you choose to print is called the print area.
If you do not select a print area, as was the case in the previous set of steps, Excel
automatically selects a print area on the basis of used cells. As you will see in future
projects, Excel has many different print options, such as allowing you to preview the
printout on the screen to see if the printout is satisfactory before sending it to the
printer.

‘witting Excel

After ;zou build, save, and print the worksheet and chart, Project 1 is complete.
'To quit Excel, complete the following steps.

FCOntrol-“menu”]
icon

| To Quit Excel

Point to the Close
button on the right
side of the fitle bar
(Figure 1-68).

Dyn n1if_'e'.r_v1us'ir."‘|tll Guarter Sales
o ; r: AR

2 RERe ?%

SR - YY)
workbook
Control-menu

wUiy LAkl o

@V’More

Saving Paper

If you are concerned with
saving paper, you can pre-
view the printout on your
screen, maoke adjustments to
the worksheet, and then print
it only when it appears exactly
as you want. The Print Preview
butten is immediately lo the
right of the Print bulton on the
Standard toolbar. Each time
you preview rather than print,
you save paper destined for
the wastepaper basket, which,
in turn, saves tfrees.

- TS

Clése ) I
button i

workbook. ’

icon

Close bulton

boscm,

"doted |

line shows 1 )
- page break i

e

Click the Close
butiton.

iEMicjns'n..
dialog box displays if

£} workbook was changed |-
since the last save ;
T TR

No hbuiton
1o exit Excel

Yes bulton o
1 without saving §!

If you made chonges fo the sevo before

workbook, the Microsoft Excel

RILPEGES

vpe 8

LIRPE L A
estion for help

dialog box displays the ques-
tion, Do you wont fo save
the changes you. made to

“Phoens

‘Dynamite Music 4th Quarter 52,350.10 | § 19554650

83 45075 | 332 D07.15

Sales.xls'2 {Figure 1-69). #
Clicking the Yes button saves’
the changes before quitting
Excel. Clicking the No button
quits Excel without saving the
changes. Clicking the Cancel
hutton cancels the exit and
returns control fo the

worksheel,

$100,000.00 i
i
$80 000,00

FIGURE 1-69

Click the No bution.

ama

1. On File menu click Exit

2. In Voice Command mode
say, “File, Exit”
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In Figure 1-68 on the previous page, you can see that two Close buttons and two
Control-menu icons display. The Close button and Control-menu icon on the title
bar close Excel. The Close button and Control-menu icon on the menu bar close the
workbook, but not Excel.

tarting Excel and Opening a Workbook

Once you have created and saved a workbook, you often will have reason to retricve
it from a floppy disk. For example, you might want to review the calculations on the
worksheet and enter additional or revised data on it. The following steps assume
Excel is not running.

Wo Start Excel and Open a Workbook

Open Office
) Cocument
1 With your floppy RO _ command
¥ disk in drive A, click
'he Sitll‘f buﬂon on “'le EilEind and apen any Office dacummint, spreadsheet, e-mail 4
S message, presentation, Web page, or databasa. B v
taskbar and then point to L
Open Office Document &y i o ScreenTip. doscribes
2 UREH N .+ Righlighted .
(Figure 1-70). den o - cominand
Start R LSS e
manu 5 R -
K Bt 5 ;:
. V‘
Start .
butlon {3 e ; T SRR : AR T G e
PErate R T SRS g Tel DRI e s L) ) R

R B R e I R A B A ol S VY, R % A R A g T T L R N S T R S T e A e e

Open Office

Click Open Office : - Docuront
Document. If AP (l0g box
necessary, click the Look “o '

in box arrow and then -
click 3% Floppy (A:) in

the Look in list. | B Nt : . desired

; g ity workbook
The Open Office Document ot g rozoft Excel Warkshot | o
4 . T Siet 17.0 KB ] creenTip includes
dialog box displays information aboul

highlighted document

(Figure 1-71). : s J' o] ocument.

FIGURE 1-71
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Double-click the file
name Dynamite
‘Music 4th Quarter Sales.

Excel starfs, opens the

workbook Dynamite Music
4th Quarter Sales.xls from
drive A, and displays it on the ; B

Dynamite Music
_Fourth Quarter Sales

X Boston Chicago Denver FReenix Totabl
screen (Figure 1-72). An [Casseltes § E346590 5 4791735 1% 3101375 1§ 5,320 10 | §195646.50 -
fternative fo double-clicki npact Oics | 0200375 | 7039200 9514085 | 83450781 337007 15 oA
alfernaiive 1o qouble-Citcking Vinlage Vinyls © 35 460, ) 4861275 L 3409275 | 49,1645 workbook opaned | ..
the file name is to click it and ‘iWeb Downloads . 70.526.17 B7 42000 | 6673260 27030572 S
) ) Total §759,497.73 ¥334,087.25 | §236,626.40 | $947,123.60
then click the Open button in

the Open Office Document
dialog box.

$100,000.00
$80,000.00 3
. $60.000.00 5 # Cassettes
! : ! = B Compact Discs
b 16|  #0.000.00 = B ) i | avinlage Vinyls
1 $20,000.00 : : | 5! | OWeb Downloads

FIGURE 1-72 o
335

1. Rightclick Start bution, click

utoCalculate Explore, display cantenls of
drive A, double-click file

You easily can obtain a total, an average, or other information about the numbers in name
a range by using the AutoCalculate area on the status bar. All you need do is select
the range of cells containing the numbers you want to check. Next, right-click the
AutoCalculate area to display the shortcut menu (Figure 1-73 on the next page). The
check mark to the left of the active function (Sum) indicates that the sum of the
selected range displays. The function commands on the AutoCalculate shortcut menu
are described in Table 1-5.

2. In Microsoft Excel, in Voice
Command mode say, "Open,
[select fils name], Open”

None . No value displays in the AvtoColeulate area

Average Diépluys the average of the numbers in the selecled range

Count Displays the number of nonblank cells in the selocted range

Count Nums Disploys the nomber of cells contuining nuinbers in the selected range
Max Displuys the highest value in the selected range

Min Displays the lowest value in the selocied range

Sum Displays ihe sum of the numbers in the selected range

The steps on the next page show how to display the average fourth quarter sales
by store for the Cassettes product group.
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Select the range
B4:E4. Right-click
the AvtoCalculate area on
the status bar.

The sum of the numbers in
the range B4:£4 displays
($195,646.50) as shown in
Figure 1-73 because Sum is
active in the AutoCalculofe
area. You moy see o fotal
other than the sum in your
AutoCalculate area. The
shortcut menu listing the
various fypes of functions
displays above the
AutoCaleuvlate area.

Click Average on
the shortcut menu.

The average of the numbers
in the range B4:£4 displays
in the AutoCalculate areo
(Figure 1-74).

Right-click the
AutoCalculate area
and then click Sum on the
shortcut menu.

The AutoCalculate area
displays the sum as shown
earlier in Figure 1-73.

v;n z ui&«%%ﬁjim % v
53465.3

Dynamite Music ,“‘?:';2.;1"9'1

Fourth Quarter Sales T
Boston Chicago Denver Phosnix - Totar
a4 [Cassettss b 53465.30 -5 47 917.35 13 31.813.75 | § 52,350 10 15195 846 50
5 ] Compact Discs 9202375 7039210 46,140 55 8346075 33200715
| 6 jVintage Vinyls 35482 56 3097625 4851275 3409278 149154 31
Web Dovmloads 73 52R 12 57 52660 57,420.20 A6732.80 030572
lolal $250, 49773 §216,912.30 $234087.25 § 23662640 $947 12368

$100,000.00
$50,000.00
$60,000.00

Average
command

B asselles

g W 8 Compact Dises

Non ]

AnMintana \l'myls

.gverage
2000000 AutoCaIcuIate area LIPS D B
§20,000.0 displays sum of values in | rads | check mark | Count i
3- range Bd:E4 fotal ! indicates <% menu
$195.645.50 clive function | count oz -
e :i. .............. et tax

Sum- 5, 195,646.

FIGURE 1-73

© Winded- el . Type aquestion forhelp . _.El_'
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: Dynamite Music st ae
2] Fourth Quarter Sales L
3 Boston Chicago Danver Phoenix_ Total
[ 4" |Cassattes £ 53465 30 1§ A7 947,35 L6 -31.953:75 1% 6235010 l § 195 546 A0
[ & |Compact Dises __92,023.95  70,392.10  B6.140.65  AIAL0 75 T32.007.15
| B {Vintage Vinyls 35,482 56 30.976.25 48561275 34,092,745 14%,104.31
7 [Web Downloads 7852612 67 626.60 B7,420.20 56.732.80  270.305.72
8 [Total F2E9497.73 $216 91230 $2341087 25 $23656.400 $947.175.68
9
]
11| s100.000.00°
12
EE} $80,000.00
0m 50 Q00,00 @Casseltes
T @ Compact Dises
[ 18] $40.000.00 DVirtage Vinyls v ;)" vél e)sl"n. i
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To change to any one of the other five functions for the range B4:E4, nght click

AU BRI BLIRE L

the AutoCalculate area, then click the desired function.

The selection None at the top of the AutoCalculate shortcut menu in Figure 1-73
curns off the AutoCalculate area. Thus, if you select None, then no value will show
in the AutoCalculate arca when you select a range.

7Y
@;orrecting Errors

You can correct errors on a worksheet using one of several methods. The method
you choose will depend on the extent of the error and whether you notice it while
typing the data or after you have entered the incorrect data into the cell.

Correcting Errors While You Are Typing Data into a Cell

If you notice an error while you are typing data into a cell, press the BACKSPACE
key to erase the portion in error and then type the correct characters. If the error is a
major one, click the Cancel box in the formula bar or press the £SC key to erase the
entire entry and then reenter the data from the beginning.

fn-Cell Editing

If you find an error in the worksheet after entering the data, you can correct the
error in one of two ways:

: Shorlcui Menus

Shortcul menus display the-
most frequently tsed com-
mands thaf relafe to the: ob|ec|
to which the mouse pointer is
pointing. To display o shortcut
menu, rightclick the object us
shOWn in Step 1. To hide a
shorteut mieny, click: outside
the: shorlcut menu or press the
£sC key. -

1. If the entry is short, select the cell, retype the entry correctly, and click the
Enter box or press the ENTER key. The new entry will replace the old entry.

2. 1f the entry in the cell is long and the errors are minor, the Edit mode may be a
better choice. Use the Edit mode as described below.

a. Double-click the cell containing the error. Excel switches to Edit mode, the
“active cell contents display in the formula bar, and a flashing insertion
point displays in the active cell (Figure 1-75). This editing procedure is
called in-cell editing because you can edit the contents directly in the cell.
The active cell contents also display in the formula bar.

b. Make your changes, as indicated below.

(1) To insert between two characters, place the insertion point between the
two characters and begin typing. Excel inserts the new characters at
the location of the insertion point.

(2) To delete a character in the cell, move the insertion point to the left of

the character you want to delete

and then press the DELETE key, or .

place the insertion point to the Mi : nani :

right of the character you want to
delete and then press the BACK-
sPAGE key. You also can use the
mouse to drag through the char-
acter or adjacent characters you
want to delete and then press the

contents of
-~ cell B3 display in

m&z

formula bar

_Dynamite Musnc

In-Cell Editing

An alternative to double-
clicking the cell to edit is to
select the cell and press F2.

Fourth Quarter Sales

DELETE key or click the Cut button &
icago

“Denver

Phoeni| _ Folat!

on the Standard toolbar.

1§ 3191375

¥ 62,350,10 | 5195 54650

When you are finished editing an
entry, click the Enter box or press
the ENTER key.

|nserllon polnt
displays in cell after

double-clicking
- FIGURE 1-75

4).55
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When Excel enters the Edit mode, the keyboard usually is in Insert mode.
In Insert mode, as you type a character, Excel inserts the character and moves all
characters to the right of the typed character one position to the right. You can
change to Overtype mode by pressing the INSERT key. In Overtype mode, Excel
overtypes, or replaces, the character to the right of the insertion point. The INSERT

Edmng the Contents

of a Cell key toggles the keyboard between Insert mode and Overtype mode.

Rather than using in-cell While in Edit mode, you may have reason to move the insertion point to various

editing, you can select the — points in the cell, select portions of the data in the cell, or switch from inserting

;e" and then click the formuta characters to overtyping characters. Table 1-6 summarizes the more common tasks
ar to edit the contents.

used during in-cell editing.

Move the insertion point to the beginning of Point to the left of the first character and dick Prass HoME
data in o cell
Move the insertion paini to the end of duta Paint to the right of the lasi character and dlick Press enp
inacell
Move the insertion point anywhere in o cell Paint to the appropriate position and click the character  Press RIGHT ARROW or LEFF ARROW
Highlight one or more adjacent characters Drug the mouse pointer through adjacent choracters Press SHIFT+RIGHT ARROW oF SHIFT+LEFT ARROW
Select all data in & cell Bouble-click the cell with the inserfion point in the cell
Delete selected charadlers Click the Cut budton on the Standard toolbar Press DELETE
Delete characters 1o the left of insertion point Press BACKSPACE
Toggle between Insert and Overtype modes Press mseRy

Undoing the Last Entry

: - Excel provides the Undo command on the Edit menv and the Undo button on the
Escaping an Activity Standard toolbar (Figure 1-76) that you can use to erase the most recent worksheet
When it comes to canceling entries. Thus, if you enter incorrect data in a cell and notice it immediately, click the
the current activity, the mas! Undo command or Undo button and Excel changes the cell contents to what they

important key on the keyboard  wyere prior (o entering the incorrect data.
is the EsC [Escape] key.

Whether you are entering
data into o cell or responding

VUndo Undo Redo

to a dialeg box, pressing the button © - bulton arrow bulton
£s¢ key cancels the cuirent i
activity. ki
I W Type a4 guestion For help
o o @ 2y 2 P -3,
< TypiridiBoston’ in 83 ol i T
Cizar ggrl fi- @ -
- Typing Bastion’ n B3
Selact T ssepe Tygiing ‘Boston' n B3
- All button . Typing Fourth Quarter Sales' in A2:F2 d | G | i | I I
. D nam ite Typing 'Boston’ In B3 - Urido list .
Typing ‘Cassettes’in A4
_j_ y Typing 'Tokaf in A . : . contains list of
Typing Thicage' in €3 recent aclions
__2‘_ Fﬂurth Quar Typing Fhoeriz' in €3 Sl s
3 Bosion Chicago _[Clesr Totai
[ 4 [Cazsettes § 534680 § 4781735 {/7Pn0 TnninBeRy 5646.50
5 _iCompact Discs 9202375 70,332.10 Cancel 2007.14
B iVintage Vinyls 3548256 30076 25 4861275 MOE275 0 149164 3
7 [Web Downloads 75 526,12 57 526.50 57 420.20 SB732.580 XDJ305.72
8 |[Totar $2659497.73 $216,912.30 §$234,087 25 - $235526.40 %947 12368
9
ki)
| 114 s100000.00
121

FIGURE 1-76
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If Excel cannot undo an action, then the Undo button is inoperative. Excel
remembers the last 16 actions you have completed. Thus, you can undo up to 16
previous actions by clicking the Undo button arrow to display the Undo list and
clicking the action to be undone (Figure 1-76). You can drag through several actions

in the Undo list to undo all of them at once. 'I'I1e llmlo BII'I'I‘OII 7
Next to the Undo button on the Standard toolbar is the Redo button. The Redo "The Urido button can dndo. for
button allows you to repeat previous actions. You also can click Redo on the Edit more complicaled worksheet

activities than just removing
the latest eniry from a cell. In
fact, most commands can be |

menu rather than using the Redo button.

o . |
Clearing o Cell or Range of Cells undone if you click the Undo |
- button before you make
If you enter data into the wrong cell or range of cells, you can erase, or clear; the another Z”"Y o issue another
data using one of several methods. Never press the SPACEBAR to clear a cell, Pressing zzgm;npn;o%jf Znsoggjno ’
the SPACEBAR enters a blank character. A blank character is text and is different from eral rule, the Undo button can
an empty cell, even though the cell may appear empty. restore the worksheet data
Excel provides four methods to clear the contents of a cell or a range of cells, and seffings to what they were

the last time Excel was in
Ready mode. With Excel
2002, you have mulfiple-level

TO CLEAR CELL CONTENTS USING THE FILL HANDLE : undo and redo capabilifies.

Select the cell or range of cells and point to the fill handle so the mouse pointer
changes to a cross hair.

which are discussed below.

Drag the fill handle back into the selected cell or range until a shadow covers
the cell or cells you want to erase. Release the mouse button.

TO CLEAR CELL COMTENTS USING THE SHORTCUT MENU

Select the cell or range of cells to be cleared.

Getting Back

to Normal
Gl Click Edit on the menu bar and then point to Clear. ) IF you accidentally assign
unwanted formats to a range
Click All on the Clear submenu. of cells, you can use the Clear

command on the Edit menu to
delete the formats of a

You also can select a range of cells and click the Cut button on the Standard :
selected range. Doing so

toolbar or click Cut on the Edit menu. Be aware, however, that the Cut button or changes the format to Norme
Cut command not only deletes the contents from the range, but also copies the style. To view the characteris-
contents of the range to the Office Clipboard. fics of the Normal style, click

Style on the Format menu or
press AlT-+APOSIROPHE ('}

Clearing the Entire Worksheet

Sometimes, everything goes wrong. If this happens, you may want to clear the
worksheet entirely and start over. To clear the worksheet, follow the steps on the
next page.
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T0 CLEAR THE ENTIRE WORKSHEEY _ )
@l Click the Select All button on the worksheet (Figure 1-76 on page E 1.50).

T 8 Press the DELETE key or click Edit on the menu bax, point to Clear and then
' click All on the Clear submenu.

The Select All button selects the entire worksheet. Instead of clicking the Select All
button, you also can press CTRL+A. You also can clear an unsaved workbook by
clicking the workbook’s Close button or by clicking the Close command on the File

 Quidc Reference |

For a table ihat lists how to
complete the fasks covered in

this book using the mouse, menu. If you close the workbook, click the New button on the Standard toolbar or
menu, shortcut menu, and click the New command on the File menu to begin working on the next workbook., '
keyboard, see the Quick To delete an embedded chart, complete the following steps.

Reference Summary at the
back of this book or visit the
sholly Cashman Series Office 10 DELETE AN EMBEDDED CHARY
XP Web page (scsite.com/ e

offxp/qr.him] and then click @ Click the chart to select it,
Microsoft Excel 2002,

Press the DELETE key.

ey
gﬁr xcel Help System

At any time while you are using Excel, you can get answers Lo questions using the
Excel Help system. You can activate the Excel Help system by using the Ask a

M@fe@aout

‘ Tﬁe Excel Help Question box on the menu bar, the Microsoft Excel Help button on the Standard
System toolbar, or the Help menu (Figure 1-77). Used properly, this form of online assis-

tance can increase your productivity and reduce your frustrations by minimizing

The best way to become . .
Y the time you spend learning how to use Excel.

tamiliar with the Excel Help

syslem is fo use it. Appendix A The following section shows how to get answers to your questions using the
includes detaifed informafion Ask a Question box. Additional information on using the Excel Help system is
- on the Excel Help systom and available in Appendix A and Table 1-7 on page E1.54.

exercises that will help you
gain confidence in using it.

Obtaining Help Using the Ask u Question Box on the Menuv Bar

The Ask o Question box on the right side of the menu bar lets you type free-form
questions such as. how do I save or how do I create a Web page, or you can type in
terms such as, copy, save, or formatting. Excel responds by displaying a list of topics
related to what you entered. The following steps show how to use the Ask a .
Question box to obtain information on formatting a worksheet,

%tcps To Obtain Help Using the Ask a Question Box
S

Help Microsoft Excel Ask a

" onmenu bar — Help bulton * Question box

Type formatting in
e the Ask a Question
box on the right side of the

menv bar (Figure 1-77).

i ST TR L B SIS 5 Vrmattinrg|
SRS AL ERLE I TR
e sujess@Elex, walEs|u. 0.4,

[ o T e T F T

namite Music

Dy

FIGURE 1-77
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Ask a Question
box arcow

Press the enter key.

When the list of
topics displays below the RERSE R S b L s e Gt G el B et i | e poier
Ask a Question box, point ez B R e savea wobockin
to the topic, About 7 7 i TR vt of topics IR Troublshoot
formatting worksheets and Dvnamite Music frmalting Wotohedts
ormalting war
du'u y he Change formatting
g Fourth Quarter Sales of text
. ) . z Eosion Chicago Denver Phoanit Total Copy farmats from
A list of topics displays {#|Cassettes § 53.465.30 |3 4791735 | 5 3101375 | 5 62,350.10 | 1960650 | | om0
. Compact Disos | 62.093.75 | 70,392.10 | _86,140.55 | 83450.75 | 332.007.15
relating to the term, Vintage Vinyls | 3548266 | 3097825 | A8 R12/5 | 3409275 | 149,164.31 ¥ seemore..
formatting. The mouse Web Downioads | 7052612 | 6769660 | 6742020 | 6573280 270306721 . 1
i Total $959.497.73 | §216,912.50 | $934,087.25 | §736,526.40 | $947,123.68
pointer changes to a hand
indicating it is pointing to a
: , $100,000.00
Aink (Figure 1-78).

FIGURE 1-78

Microsait Excel &
Halp window Print bon
I— bukton button
) help on the topic A,
i Microsoft Excel | j j About fermatting il
::IICk AbOI.I‘ # worksheets and data
ormattin Options 5
g et e d budton t
worksheets and | AuoTie _ i ,
d t wh th button About forimatting worksheets and data
ata. en e T A Use these Foreatting faatures to effectively display your data,
MIC'OSO" Excel Hel p g;”md Format text and Individual characters Tomake text stand out, you can format afl of the text In a cell or
wi d di I(I s boﬂton o h. 1 se!eugted characters, Select the characters you want to Farmat, and then click a button on the Formatting
naow H 41 toolbar,
p ' r e R TS IS R EINT
double-~click its title bar AL B !
to muximlze “- Rotate text and borders The data in a column is often very narrow while the labet for the column is much

wider, Instead of creating unnecessarily wide columns or abbreviated labels, you can rotate text and apply

o Back and borders that ara rotated to the sams dagree as the text.

Excel opens a Microsoft ’Forward buttons : A

. : 37 M - S (s 1
Excel Help window that 9‘“‘0‘);"6‘&“&6 il

. : , o
provides Help rnformahgn ol e
about worksheet formatting , ] el )
. i 1 . 9 .=
{Figure 1-79). e 2% 5% -
Add borders, colors, and patterr;s To distinguish between dfferent types of information iy a worksheet, you
c“ck 'he CIose ; tan apply borders to cells, shade cells with a background calor, or shade cells with a color pattern.

button on the
Microsoft Excel Help
window title bar.

The Microsoft Excel Help
window closes and the
worksheet is active.

FIGURE 1-79

Use the buttons in the upper-left corner of the Microsoft Excel Help window e in:

. : . ) Excel Tips.

(Figure 1-79) to navigate through the Help system, change the display, and print the e o

-ontents of the window. : To receive o newslefter titlad

¢ . . . ExcelTips regularly via e-mail
As you enter questions and terms in the Ask a Question box, Excel adds them at no charge, visit the Excel

to its list. Thus, if you click the Ask a Question box arrow (Figure 1-78), a list of 2002 More About Web page

previously asked questions and terms will display. fscsite.com/ex2002/more. him)
and click ExcelTips.
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Table 1-7 summarizes the 11 categories of Help available to you. Because of
the way the Excel Help system works, be sure to review the rightmost column of
Table 1-7 if you have difficulties activating the desired category of Help. Additional
information on using the Excel Help system is available in Appendix A.

e
Answer Wizard

'_ Answers questions or searches for terms that you type in

SnpR
'?.ﬂ\g‘a 3 s

yOUF own words.

Click the Micro

i ~_%§F" i L
soft Excel Help button on {
toolbar. Click the Answer Wizard tah.

LA N

I;e Standard

Ask a Question box

Answers questions or searches for terms thal you type in
yOur awn words,

Type a question or ferm in the Ask o Question box on the
menu bar and then press the euTeR key.

{ontents sheet

Groups Help topics by general categories. Use when you
know only the.general category of the fopic in question.

Click the Microsoft Excel Help button on the Standard
toalbar. Click the Contents tab.

Detect and Repair

Aulpmu_liﬁully finds and fixes errors in the application.

Click Detect and Repair on the Help menv.

Hardware ond Seftware Information

Shows Product. 10 and allows access to system information
and technical support information.

Click About Microsoft Excel on the Help menu and then
click ihe appropriate butten.

Help for Lotus 1-2-3 Users

Used to assist Lotus 1:2-3 users who are learning
Microsoft- Excel..

Click Lotus 1-2-3 Help on the Help menu.

Index sheet

Sirmilar fo an index in o book, Use when you know exactly
what you want.

Click the Microsoft Excel Help bution on the Standard
oolbar, If necessary, maximize the Help window by
double-clicking its title bar. Click the Index tab.

Office Assisiant

Similar to the Ask o Question box in that the Office
Assistant answars-questions that you type.in your ewn
words, offers fips, and provides help for o variety of
Excel faatures,

Click the Office Assistant icon, If the Office Assistant
does not display, click Show the Office Assistant on the
Halp meny.

Office on the Weh

Used fo access technical resources and download free
product enhancements on the Web.

Click Office on the Web on the Help menu. -

Question Mark buttan

Used to identify unfumiliar items in a dialog box.

Click the Question Mark button in the title bar of a
dialog box and then click an item in the diolog box.

What's This? command

Used to identify unfumiliar items on the sereen.

Click Whot's This? on the Help menv, and then dick an
item on the screen,

Quitting Excel -

" Do riot forget lo remove your
ficppy disk from drive A after
quitling Excel, especialy if
you are working in a labora-
fory environment. Nothing can
be more frustrating than leav-

~ing all of your hard work
bshind on a floppy disk for
the next user.

Quitting Excel

To quit Excel, complete the following steps.

TO QUIT EXCEL

page E 1.45).

Bl Click the Close button on the right side of the title bar (see Figure 1-68 on

If the Microsoft Excel dialog box displays, click the No button.
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CASE PERSPECTIVE SUMMARY

The worksheet created in this project allows: 1he management of Dynclmn‘e Music. 16 examlne fourth quarter sc:les for
_the four key product groups. Furthermore, the 3-D Column chan‘ should meet the needs of Nodlne lechell who as
you recqlf, ;would rather view ihe numbers graphlccrlly

E roject Summary

- In creating the Dynamite Music Fourth Quarter Sales worksheet and chart in this project, you gained a broad
- knowledge of Excel. First, you were introduced to starting Excel. You learned about the Excel window and
" how to enter text and numbers to create a worksheet. You learned how to select a range and how to use the
AutoSum button to sum numbers in a column or row. Using the fill handle, you learned how to copy a cell
to adjacent cells.

Once the worksheet was built, you learned how to change the font size of the title, bold the title, and center
the title across a range using buttons on the Formatting toolbar. Using the steps and techniques presented in the
project, you formatted the body of the worksheet using the AutoFormat command, and you used the Chart
Wizard to add a 3-D Column chart. After completing the worksheet, you saved the workbook on disk, printed

the worksheet and chart, and then quit Excel. You learned how to start Excel by opening an Excel document,
use the AutoCalculate area, and edit data in cells. Finally, you learned how to use the Excel Help system to
answer yout questions.

hat You Should Know

Having completed this project, you now should be able to perform the following tasks:

# Add a 3-D Column Chart to the Worksheet (E 1.37) b Save a Workbook (E 1.41)

5 Bold a Cell (E 1.29) B Start Excel (E 1.08)
3 Center a Cell’s Contents across Columns (E 1.32) B Start Excel and Open a Workbook (E 1.46)
» Change the Font Color of a Cell (E 1.31) P Sum a Column of Numbers (E 1.23)
5 Clear Cell Contents Using the Clear Command (E 1.51) P Use AutoFormat to Format the Body of a
® Clear Cell Contents Using the DELETE Key (E 1.51) Worksheet (E 1.33)
b Clear Cell Contents Using the Fill Handle (E 1.51) b Use the AutoCalculate Area to Determine an
? Clear Cell Contents Using the Shortcut Menu (E 1.51) Average (E 1.48)
® Clear the Entire Worksheet (E 1.52) b Use the Name Box to Select a Cell (E 1.35)
3 Copy a Cell to Adjacent Cells in a Row (E 1.25) —_—
p Customize the Excel Window (E 1.09)
® Delete an Embedded Chart (E 1.52)
» Determine Multiple Totals at the Same Time (E 1.27) ' Microsoft _
B Enter Column Titles {E 1.19) Certification
b Enter Numeric Data (E 1.22) 7 The Microsoft Office User
b Enter Row Titles (E 1.21) Specialit MOUS)
. ertification program provides
b Enter the Worksheet Titles (E 1.17) an opportunity for you fo
B Format the Worksheet Subtitle {E 1.33) obrqin a valuable industry cre-
. - dential — proof that you have
» Increase the Font Size of a Cell Entry (E 1.30) the Excel 2002 skills required
» Obtain Help Using the Ask a Question Box (E 1.52) by employers. For more infor-
. - mation, ses Appendix E.or
b Print a Worksheet (£ 1,44) visit the Shelly Cashman
& Quit Excel (E 1.45, E 1.54) Series MOUS Web page af

sesite.com/offxp/cert:him,




f? Marco Polo’s Trave! Bookstore 1st Quarter Sales Worksheet

Instructions:  Start Excel. Open the workbook Magellan’s

Travel Bookstore 1t Quarter Sales from the Data Disk.
Sce the inside back cover of this book for instructions for
downloading the Data Disk or see your instructor for
information on accessing the files required in this book.
Make the changes to the worksheet described in Table 1-8
so it appears as shown in Figure 1-80. As you edit the values
in the cells containing numeric data, watch in the totals in row
8, the totals in column G, and the chart change. When you
enter a new value, Excel automatically recalculates the formu-

M
B4 78,221.46
& 69,789.50
06 74,943.13
Fb 86,699.98
F7 98,421.43

fas. After you have successfully made the changes listed in the
table, the total sales in cell G8 should be $1,486,082.12.

e

Alr Travel  § 7822146
Land Travel  98943.20
Sea Travel ~ 75867.00
Thine Travel 72 581.64

1st Quarter Sales

62,490.86
75587.20
69,777.64

99 565.33
74843.13
54,888.60

\riBfica S [l
B9709.50 § 7743438 % 75987.50

8566790
5347993
54,156.47

me’ﬂﬂﬂSTrmﬂkaﬁm o

Hiddle Ead
$ 51673.82
63,857.10
85,689.98
98,421 43

$ 353.106.63
10352 41

37279730

34982578

Total $32543330 327805322 $308,921.34 $275.311.86

“$300,352.40

5148608212

10000000 ¢
$60,000.00
$60,000.00
$40,000.00
$20,000 00

@Ar Travel
mLand Travel
o Sea Travel

OTime Travel

Merge and Center button.

FIGURE 1-

80

~ To learn how to split cells; click cell A1 and then click the Merge and Center button to split cell Al into
cells A1, B1, C1, D1, E1, F1, and G1. To re-merge the cells into one, select the range A1:G1 and click the

Enter your name, course, laboratory assignment number, date, and instructor name in cells A24 through
A28. Save the workbook. Use the file name, Marco Polo’s Travel Bookstore 1st Quarter Sales. Print the revised
worksheet and hand in the printout to your instructor.
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Problem: The president of Madonna’s Virtual Sojourn, a travel agency that courts college age students, needs a
sales analysis worksheet similar to the one shown in Figure 1-81. Your task is to develop the worksheet.

q
7

Aruba Bahamas Daytona Key West

C¥ MBB7LIT § '5'62,_195._50 § A7 41265 § 2591983 3
438235350 86245175 24703485 - 45692006 \rigReERegy )
27256735 - 372516142 - 72435486 577.019.32 &

" . B3BE67.35 6793464 . 33082140  262.338.25
\Tatal - 8179806233 $2.976098.01 $1758573.77 51 64.478.17 &
: E ' [ |

§1,000,000.00
$800,600.00 .
3200 000.00 f i':all
3 : ampus
He0.0m.00 2 L | : o Telgphone
$200,000.00 £ = [ owe

FIGURE 1-81

Instructions: Perform the following tasks.

1. Create the worksheet shown in Figure 1-81 using the sales amounts and categories in Table 1-9.

Hail 13 56219550 4:%7,412.65 259,198.34
Campus 438,235.50 86245175 247,034.86 455,922.26
Telephone ~ 272,567.5 372,516.12 724,354 .86 577,019.32
Web 63858735 57913444 339,821.40 252,338.25

2. Determine the totals for the types of sales channels, travel destinations, and company totals,

3. Format the worksheet title, Madonna’s Virtual Sojourn, to 26-point Arial, bold brown font, centered across
columns A. through E Do not be concerned if the edges of the worksheet title do not display.

4. Format the worksheet subtitle, Annual Sales Analysis, to 18-point Arial, bold brown font, centered across
columns A through F
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£ Rozor Shorp Scooter 3¢ Quarter Expenses Worksheet

Format the range A3:F8 using the AutoFormat command on the Format menu as follows: (a) Select the
range A3:F8 and then apply the table format Accounting 1; and (b) with the range A3:F8 still selected,
apply the table format Colorful 2. Excel appends the formats of Colorful 2 to the formats of Accounting 1.
Select the range A3:E7 and then use the Chart Wizard button on the Standard toolbar to draw a Clustered
column with a 3-D visual effect chart (column 1, row 2 in Chart sub-type list). Move the chart to the
upper-left corner of cell A10 and then drag the lower-right corner of the chart location to cell F21. If all the
labels along the horizontal axis do not display as shown in Figure 1-81, select a cell in column E click
Format on the menu bar, point to Column on the Format menu, click Width on the Column submenu,
increase the column width by two or more units, and then click the OK button.

Enter your name, course, laboratory assignment number, date, and instractor name in cells A24 through A28.
Save the workbook using the file name Madonna’s Virtual Sojourn Annual Sales Analysis.

Print the worksheet. '

Make the following two corrections to the sales amounts: $596,321.75 for Bahamas sales by telephone
(cell C6), $157,390.58 for Key West sales by mail (cell E4). After you enter the corrections, the company
totals should equal $7,599,460.15 in cell F8.

Print the revised worksheet. Close the workbook without saving the changes.

Problem: As the chief accountant for Razor Sharp Scooter, Inc., the vice president has asked you to create
a worksheet to analyze the 3rd quarter expenses for the company by department and expense category
(Figure 1-82). The expenses for the 3¢ quarter are shown in Table 1-10.

Benefits 12378.23 e 15823.10 10301.60 4123.89
Travel 13761.45 15300.89 6710.35 18430.15 6510.25
Wages 18001.27 13235.50 17730.58 12000.45 20931.53
Other 143,20 3897.21 4910.45 8914.34 1201.56

Instructions: Perform the following tasks.

. Create the worksheet shown in Figure 1-82 on the next page using the data in Table 1-10.

Direct Excel to determine totals expenses for the five departments, the totals for each expense category, and
the company total.

Format the worksheet title, Razor Sharp Scooter, in 24-point Arial bold violet font, and center it across
columns A through G.

Format the worksheet subtitle, 3rd Quarter Expenses, in 18-point Arial bold violet font, and center it across

'

columns A through G.

(continued)
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FIGURE 1-82

Use the AutoFormat command on the Format menu to format the range A3:G8. Use the table format
Accounting 2.

Use the ChartWizard button on the Standard toolbar to draw the 3-D Cone chart (column 1, row 1
in the Chart sub-type list), as shown in Figure 1-82, Chart the range A3:F7 and use the chart location
A10:G21. If all the labels along the horizontal axis do not display as shown in Figure 1-82, select a cell
in-column G, click Format on the menu bar, point to Column on the Format menu, click Width on the
Column submenu, increase the column width by two or more units, and then click the OK button.

Enter your name, course, laboratory assignment number, date, and instructor name in cells A24 through
A28,

Save the workbook using the file name, Razor Sharp Scooter 3rd Quarter Expenscs. Print the worksheet.
Two corrections to the expenses were sent in from the accounting department. The correct expenses are
$22,537.43 for wages in the Finance department and $21,962.75 for travel in the Sales department. After
you enter the two corrections, the company total should equal $240,310.97 in cell G8. Print the revised
worksheet.

Use the Undo button to change the worksheet back to the original numbers in Table 1-10. Use the Redo
button to change the workshect back to the revised state.

Hand in all printouts to your instructor. Close the workbook without saving the changes.




3 College Cash Flow Analysis Worksheet

Problem: Attending college
is an expensive proposition

and your resources are lim-

ited, To plan for your four- R i Rk I
5,025.00 5326.50 5646.09 3984.86

year college career, you have

decided to organize your 1,525.00 161650 1713.49 1816.30
anticipated resources and Parents 2,600.00 2756.00 2921.36 3096.64
expenses in a worksheet. Savings - 1,100.00 1166.00 1235.96 1310.12

The data required to prepare
your worksheet is shown in

(lathes 54ﬁ.00 572.40 606.74 643.15

Table 1-11.
Entertainment 725.00 7168.50 814.61 863.49
Part 1 Instruckions: Using Miscellensous 355.00 376.30 398.88 42281
" the numbers in Table 1-11, Room & Board " 3480.00 3686.80 391013 4144.74
follow the steps below to Tuition & Books 5150.00 §459.00 5786.54 §133.73

create the worksheet shown
in columns A through F in
Figure 1-83 on the next page.

1. Enter the worksheet title in cell A1 and the section titles, Resources and Expenses, in cells A2 and A9,
respectively. “

2. Use the AutoSum button to calculate the totals in rows 8 and 16 and column E

3. Increase the font in the worksheet title to 24 and change its color to red. Center the worksheet title in cell
A1 across columns A through E Increase the font size in the table titles in cells A2 and A9 to 18 and change
their color to green.

4, Format the range A3:F8 using the AutoFormat command on the Format menu as follows: (a) Select the
range A3:F8 and then apply the table format Accounting 1; and (b} with the range A3:F8 still selected,
apply the table format List 1, Format the range A10:F16 using the AutoFormat command on the Format
menu as follows: (a) Select the range A10:F16 and then apply the table format Accounting 1; and (b} with
the range A3:F8 still selected, apply the table format List 1. .

5. Enter your name in cell A19 and your course, laboratory assignment number, date, and instructor name in
cells A20 through A23. Save the workbook using the file name, College Resources and Expenses.

6. Print the worksheet in landscape orientation. You print in landscape orientation by clicking Landscape on
the Page tab in the Page Setup dialog box. Click Page Setup on the File menu to display the Page Setup dia-
log box. Click the Save button on the Standard toolbar to save the workbook with the new print settings.

7. All Junior-year expenses in column D increased by $500. Re-enter the new Junior-year expenses. Change the
financial aid for the Junior year by the amount required to cover the increase in expenses. The totals in cells
F8 and F16 should equal $47,339.82. Print the worksheet. Close the workbook without saving changes.
Hand in the two printouts to your instructor. -

(continued)
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FIGURE 1-83
Part 2 Instructions:  Open the workbook College Resources and Expenses created in Part 1. Draw a 3-D Pie
chart in the range G3:J8 that shows the contribution of each category of resource for the freshman year. Chart -
the range A4:B7. Add the Pie chart title shown in cell G2 in Figure 1-83. Change the Pie chart title’s font to
12-point, bold green. Center the Pie chart title over the range G2:J2. Draw a 3-D Pie chart in the range G10:]16
that shows the contribution of each category of expense for the Freshman year. Chart the range A11:B15. Add
the Pie chart title shown in cell G9 in Figure 1-83. Change the Pie chart title’s font to 12-point, bold green.

Center the Pie chart title over the range G9:J9. Save the workbook using the file name, College Resources and
Expenses 2. Print the worksheet. Hand in the printout to your instructor.

Part 3 Instructions:  Open the workbook College Resources and Expenses 2 created in Part 2. A close inspection
of Table 1-11 on the previous page shows a'6% increase each year over the previous year. Use the Ask a Question
box on the menu bar to learn how to enter the data for the last three years using a formula and the Copy com-
mand. For example, the formula to enter in cell C4 is =B4 * 1.06. Enter formulas to replace all the numbers in the
range C4:E7 and C11:E1S5. If necessary, reformat the tables as described in Part 1. The worksheet should appear

~ as shown in Figure 1-83, except that some of the totals will be off by 0.01 due to round-off errors. Save the work-
shéet using the file name, College Resources and Expenses 3. Print the worksheet. Press CTRL+ACCENT () to
display the formulas. Print the formulas version. Hand in both printouts to your instructor,




The difficulty of these case studies varies:
B are the least difficult; BB are more difficult; and BB are the most difficult.

P You work part time for
Kylie’s Pet Shop. Your primary
responsibilities include caring for
the pets. Your manager, Elma
Presley, recently learned that you

are enrolled in a computer class.

She has asked you to prepare a

worksheet and chart to help her

analyze the 3« quarter sales by
store and by pet (Table 1-12).
Use the concepts and techniques
presented in this project to create
the worksheet and chart.

Rt ek

B  Computer Discount Sales
sells computers throughout the
state of Indiana. The number of -
servers, desktop computers, note-
book computers, and handheld

computers sold has increased each

year from 1998 through 2002, as

indicated in Table 1-13. Create a

worksheet and 3-D Column chart
that illustrates these increases. Use

the concepts and technigues pre-
sented in this project to create the
worksheet and chart.

T Ry A B T T O B e Fo

D As a newspaper reportes, you are prepar-
ing an article on the coming election based on
a recent survey of the electorate, arranged by
age of those polled (Table 1-14). You have

been asked to produce a worksheet to accom-

pany your article. Use the concepts and tech- Groen 625 301
niques presented in this project to creaté the Sahol 235 79
worksheet and an embedded Column chart. Walker 452 139

Wehh M 521




)
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P Alyssa’s Boutique on St Avenue in New York sells costume jewelry to an exclusive clientele. The
company is trying to decide whether it is feasible to open another boutique in the Boston area. You have §
been asked to develop a worksheet totaling all the revenue received last year from customers living in

the Boston area. The revenue from customers living in the Boston area by quarter is: Quarter 1,
$104,561.38; Quarter 2, $91,602.55; Quarter 3, $258,220.10; and Quarter 4, $333,725.25. Create a

3-D Pie chart to illustrate Boston-area revenue contribution by quarter, Use the AutoCalculate area to

find the average quarterly revenue. :

T3 o

T

BB The Virtual Reality Theater is a movie house that shows virtual reality movies at weekday evening,
weekend matinee, and weekend evening screenings. Three types of tickets are sold at each presentation:

general admission, senior citizen, and children. The theater management has asked you to prepare a 1
worksheet, based on the revenue from a typical week, that can be used in reevaluating its ticket struc- ;
ture. During an average week, weekday evening shows generate $9,835 from general admission ticket b
sales, $5,630 from senior citizen ticket sales, and $1,675 from children ticket sales. Weekend matinee :
shows make $7,250 from general admission ticket sales, $2,345 from senior citizen ticket sales, and :
$3,300 from children ticket sales. Weekend evening shows earn $9,230 from general admission ticket :

Lo

sales, $8,125 from senior citizen ticket sales, and $1,600 from children ticket sales, Use the concepts and
techniques presented in this project to prepare a worksheet that includes total revenues for each type of
ticket and for each presentation time, and a Bar chart illustrating ticket revenues,

BBB Achletic footwear stores must track carefully the sales of their different shoe brands so they can
restock their inventory promptly. Visit an athletic shoe store and make a list of the top five brands of
running shoes. Find out how many of each brand was sold each of the last three months, Using this
information, create a worksheet showing the number of each brand sold each month, the total number
of running shoes sold each month, the total number of each brand sold over three months, and a total
number of all running shoes sold over three months. Include a 3-D Column chart to illustrate the data.

4 B %

PBD Visit the Registrar’s office at your school and obtain the ages of students majoring in at least five
different academic departments this semester. Separate the ages of the students in the departments by
four different age groups. Using this information, create a worksheet showing the number of attending

students by age group in each department. Include totals and a 3-D Column chart.

il Bi
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